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1.0  Back Roads Explorer License Agreement   
 
BY INSTALLING THIS SOFTWARE, YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS 
AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THE 
SOFTWARE. RETURN THE SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT WITHIN 30 DAYS OF 
THE DATE OF PURCHASE FOR A FULL REFUND. 
 
1. Grant of License.  This Agreement permits you (“Licensee”) to use the enclosed copyrighted machine readable 
software program and associated data files that comprise Back Roads Explorer (“Software”) and the Back Roads 
Explorer User’s Guide (“Documentation”). This agreement permits you to use the Software to create customized maps, 
elevation profiles, exports for use with Pocket TOPO!, exports for use with GPS receivers, graphic files, and 
MapXchange  (.tpo  format) files that can be output from the program. Any map, elevation profile, export for Pocket 
TOPO!, export for GPS receivers,  graphics, or MapXchange (.tpo format)  file that is generated from the software will 
be referred to in this license as a “Reproduction.”  This Agreement is a license agreement and not a sale of a software 
product. The Software, Documentation, and Reproductions are furnished for your use and remain the property of 
National Geographic. 
 
This Software is licensed to you to serve as a general reference for your personal, business, or institutional use. The 
geographical data used in the Software is based on USGS topographic maps, USGS elevation data, the USGS 
Geographic Names Information System and Geographic Data Technologies Inc, geographic databases . Please consider 
carefully the fact that the Back Roads Explorer software and the geographic data may not be adequate for purposes 
requiring precision in depiction of geographic features, exact measurement of direction or distance, or for similar 
purposes including but not limited to navigation, tracking, or emergency response. 
 
This License grants you the right to use the Software on a single personal computer and a single handheld computer.  It 
does not authorize network use of any kind. You may not decompile, disassemble, or use any method to discover the 
trade secrets contained in the Software. You may not modify, adapt, translate, rent, lease, timeshare, or loan the 
Software.  You may copy elements of the Software onto the hard disk of your computer and load elements of the 
Software into RAM and the CPU of your computer. 
 
You may transfer your rights under this Agreement by providing the recipient the Software and Documentation, 
provided that you retain no copies of the Software or Documentation and that the other party agrees to the terms of this 
License Agreement.  
 
2. Output Limitations.   
 
Hardcopy print-outs 
 
This license grants you the right to create and reproduce an unlimited number of hard copy Reproductions for your 
personal, in-house business, or intra-institutional use, subject to the property rights notice and credit requirements set 
forth below. We ask that the National Geographic and GDT copyright notices appear in legible form on or adjacent to 
the reproduction in the following form.  For Maps: “Map created with TOPO!® ©2003 National Geographic; ©2003 
GDT, Inc. 09/2003”. For Profiles: “Profile created with TOPO!® ©2003 National Geographic. 
 
You may distribute hard copy Reproductions on paper, as long as the Reproductions are distributed freely, without 
charge, in a non-commercial manner and the National Geographic copyright notice appears in legible form or National 
Geographic is given legible credit as described in paragraph 1 of the output limitations section. We ask that you obtain 
a supplemental license in writing from National Geographic before you reproduce any Reproductions in a publication 
that is for sale, resale or that contains paid advertisements.  
 
Exports for Pocket TOPO!  
 
You may use the Software to create and transfer Reproductions to a handheld device for use with Pocket TOPO! for 
your personal  use. 
 
Exports for GPS receivers 
 
You may use the Software to create and transfer Reproductions to GPS receivers for your personal use. 
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MapXchange files (.tpo & .tpg) 
  
You may use the Software to create and distribute an unlimited number of MapXchange (.tpo  format) files to other 
licensed Back Roads Explorer & TOPO! users via e-mail, ftp, and removable storage media as long as the 
Reproductions are distributed freely, without charge, in a non-commercial manner in the .tpo format that can be read by 
the TOPO! software.  MapXchange .tpo files created for export to handhelds may not be distributed and are for your 
personal use. To learn more about posting and downloading MapXchange files visit 
www.nationalgeographic.com/mapxcchange. 
 
Imagery for websites 
 
We ask that you obtain a supplementary license in writing from National Geographic before you reproduce display or 
distribute any Reproductions as Graphic Images over the Internet or other electronic networks. Please contact National 
Geographic for more details for extended use licenses at topo@ngs.org. 
 
3. Property Rights.  The Software, Documentation, and the Data that comprises the Reproductions are owned and 
copyrighted by National Geographic and / or Geographic Data Technology Inc. with all rights reserved. You may make 
one copy of the Software for backup purposes. The Software represents and embodies trade secrets of National 
Geographic and/or its licensors. These trade secrets are not licensed to you, and any modification, addition, or deletion 
is prohibited. You agree to take all reasonable steps to protect the Software from unauthorized copying or use. 
 
4. Term.  This License is effective until terminated.  This License and your right to use the Software terminate 
automatically if you violate any part of this agreement. Should the Agreement be terminated, you agree to return all 
copies of the Software, Documentation, and Reproductions furnished to you, or made by you, and all copies to National 
Geographic, including copies resident in the computer’s memory. 
 
5. U.S. Government Restricted Rights.  If this Software is acquired by or on behalf of any unit or agency of the United 
States Government, this provision applies. This Software (a) was developed at private expense, and no part of the 
software application was developed with government funds, (b) is a National Geographic trade secret for all purposes 
of the Freedom of Information Act, (c) is restricted computer software submitted with restricted rights in accordance 
with 52.227-19 (a) through (d) of the Commercial Computer Software Restricted Rights Clause and successors, (d) in 
all respects is proprietary data belonging solely to National Geographic, and (e) is published and all rights are reserved 
under the copyright laws of the United States. For units of the Department of Defense (DOD), t his Software is licensed 
only with Restricted Rights as that term is defined in the DOD Supplement to the Federal Acquisition Regulations, 
52.227-7013 (c) (1) (iii) and its successors. Use, duplication, or disclosure of the Software by the Government is 
subject to restrictions as set forth in subdivision (b)(3)((ii) of the Rights in Technical Data and Computer Software 
clause at 252.227-7013 of the DOD FAR. Contractor/manufacturer is National Geographic, 375 Alabama Street, Suite 
400, San Francisco, CA 94110. 
 
6. Export Laws.  Licensee understands that the product may require a license from the U.S. Department of Commerce 
or other government agency before it may be taken or sent outside of the United States. Licensee agrees to obtain any 
required license before taking or sending the Software outside the United States. Licensee will not permit the export or 
re-export of the Software without obtaining required licenses of letters of further assurance. 
 
7. Governing Law.  This agreement will be governed by, and interpreted in accordance with; the laws of the State of 
California of the United States of America as applied to transactions entirely within California between California 
residents. 
 
8. Entire Agreement.  This agreement sets forth the entire understanding and agreement between National Geographic 
and you, and may be amended only in a writing signed by both parties. NO VENDOR, DISTRIBUTOR, DEALER, 
RETAILER, SALES PERSON, OR OTHER PERSON IS AUTHORIZED TO MODIFY THIS AGREEMENT OR TO 
MAKE ANY WARRANTY, REPRESENTATION, OR PROMISE WHICH IS DIFFERENT THAN, OR IN 
ADDITION TO, THE REPRESENTATIONS OR PROMISES OF THIS AGREEMENT. 
 
9. Waiver.  No waiver of any right under this agreement will be effective unless contained in writing, signed by a duly 
authorized representative of National Geographic, and no waiver of any past or present right arising from any breach or 
failure to perform will waive any future right arising under this agreement. 
 
10. Severability.  If any provision in this agreement is invalid or unenforceable, that provision will be interpreted, 
limited, modified, or, if necessary, severed, to the extent necessary, to eliminate its invalidity or  
unenforceability, and the other provisions of this agreement will remain unaffected. 
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Limited Warranty and Warranty Disclaimer 
 
1. Limited Warranty and Warranty Disclaimer. National Geographic warrants the disk on which the Software is to be 
distributed to be free from defects in materials and workmanship and that the unaltered Software will perform 
substantially in accordance with the documentation for a period of 90 days from the date you purchased the license to 
the Software. Any written or oral information, or advice given by National Geographic’ dealers, distributors, or 
employees will in no way increase the scope of this warranty.  
 
National Geographic makes no other warranties, express or implied, including, without limitation, the implied fitness 
for a particular purpose, regarding the Software. National Geographic does not warrant, guarantee or make any 
representations regarding the use or the results of the use of the Software in terms of its correctness, accuracy, 
reliability, currency or otherwise. You assume the entire risk as to the results and performance of the Software. 
 
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHT. YOU MAY HAVE OTHERS, WHICH 
VARY FROM JURISDICTION TO JURISDICTION.  
 
NATIONAL GEOGRAPHIC IS IN NO WAY RESPONSIBLE FOR PERSONAL INJURY OR DAMAGE TO 
PROPERTY IN CONNECTION WITH THE USE OF ITS SOFTWARE OR GEOGRAPHICAL DATA.  IN NO 
EVENT WILL NATIONAL GEOGRAPHIC, AND ITS DIRECTORS, OFFICERS, OR EMPLOYEES BE LIABLE 
TO YOU FOR ANY  
 
CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING BUT NOT LIMITED TO 
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, AND LOSS OF BUSINESS 
INFORMATION) ARISING FROM THE USE OR THE INABILITY TO USE THE SOFTWARE, AND THE 
ACCOMPANYING WRITTEN MATERIALS. 
 
2. Exclusive Remedy.  Your exclusive remedy, as well as National Geographic and its suppliers entire liability arising 
from, or in connection with the Software, Documentation, Reproduction and/or this License, will be the refund of the 
license fees, or the replacement of defective components of the Software. In no event will National Geographic’ total 
liability for any damages, direct or indirect, in connection with the product, the product documentation, and/or this 
License exceed the license fees paid for your right to use this copy of the product whether such liability arises from any 
claim based upon contract, warranty, tort or otherwise. 
 
© 2003 National Geographic. All Rights Reserved.  V. 3- Back Roads Explorer  
TOPO! and Pocket TOPO! are trademarks of National Geographic. TOPO! is a registered trademark. 
GIF-LZW Software Licensed under U.S. Patent No. 4,558,302 and foreign counterparts. 
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2.0  Welcome to Back Roads Explorer 
 
Thank you for your purchase of National Geographic Back Roads Explorer. This product features high 
quality digital maps based on U.S. Geological Survey, National Geographic data, and GDT street data.  
This product is p owered by state of the art map browser software (TOPO! version 3). This user guide is 
intended to familiarize you with the map browser software.  TOPO! software provides everything you need 
to navigate, explore, and print customized topographic maps. TOPO! makes it easy to measure distance and 
direction, build elevation profiles, determine coordinates, and print customized maps.  
 
We strongly recommend that all users read chapter 4, For People Who Don’t Like to Read Manuals. 
GPS users should at least browse chapter 14, Customizing the Maps with Waypoints and Grids, and 
chapter 15, Using Back Roads Explorer with a GPS Receiver. To get help with Back Roads Explorer 
see chapter 5, Accessing Other Information and Getting Help, or Appendix E, Troubleshooting.  
 
We hope you find Back Roads Explorer useful, easy to use, and enjoyable. Please contact us for 
information about new products. We appreciate any feedback and suggestions you may have. 
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3.0  Installing and Running Back Roads Explorer 
 
System Requirements: 
• Microsoft Windows 95, 98, 2000, NT, ME or XP 
• 16 MB of memory 
• Double speed CD-ROM drive 
• 486 DX/66MHz PC or higher 
 
Installing and Running Back Roads Explorer 
 
Use the TOPO! installer (setup.exe) to install Back Roads Explorer.  It will place the TOPO! application 
and other files  Back Roads Explorer needs to run properly onto your hard drive. 
 
To install Back Roads Explorer: 
 
1. Insert the Back Roads Explorer Installer CD-ROM 
2. Choose the “Run” command from the Start Menu 
3. Type “D:\Setup.exe”  (If your CD-ROM is not drive D: substitute the correct drive letter in place of “D”) 
4. Click “OK” and follow the instructions on the screen 
5. The TOPO! Install Wizard with place the TOPO! application and other files Back Roads Explorer needs 
to run properly onto your hard drive 
 
To run Back Roads Explorer: 
 
1. From the Windows Start menu, choose Programs, then choose TOPO!. 
2. When the welcome screen appears, click Go to start a new map. 
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4.0  For People Who Don’t Like to Read Manuals 
 
Reading this short chapter will point out some of key features that are easy to miss. GPS users should also 
browse chapter 15, Using Back Roads Explorer with a GPS Receiver. 
 
4.1 Pop-up Option Menus 
 
Many of Back Roads Explorer’s most important features, such as elevation profiling, can only be accessed 
from pop-up editors. All objects that you add to maps (routes, waypoints, direction lines, symbols, text 
labels, and notes) contain pop-up editors that provide options. These menus can be accessed by placing 
your cursor over an object and clicking the right mouse button. Don’t miss them. 
 
(Tip: Waypoints and GPS routes can only be edited or activated when you are using the Waypoint Tool. To 
pop-up an option menu on a waypoint, be sure you are using the Waypoint Tool.) 
 
4.2 Using the Status Bar 
 
The status bar running along the bottom of the TOPO! window provides real-time help and information.  
The status bar is an excellent way to learn to use all of TOPO!’s features. Check it frequently for tips, help 
with tools, route mileages and information about custom objects. 
 
4.3 Quick Guide to Printing 
 
Most of the maps are much larger than a printed page. The Print Tool allows you to easily define a page-
sized area of map for printing or exporting maps to a handheld. To print a map from TOPO!, you need to 
do the following:   
 
1. Choose Print from the File menu. A red rectangle with an “X” through its center will appear on the map. 
This rectangle shows the current Selection Area; its size defaults to the amount of map that will exactly fit 
on the printed page. 
2. Left click on the map at the center of the area you wish to print. (You can also drag the Selection Area 
rectangle around on the map to adjust the print boundaries). 
3. Click the Print Map button at the lower right portion of the screen. 
 
(Tip: If you are not printing on a color printer, go to the Preferences menu and select the Print Tool 
submenu. Then select Output to Grayscale. This setting will give you the best output to a black & white 
printer.) 
 
For more information about printing maps, see chapter 12, Printing, Copying and Exporting Maps. 
 
4.4 Downloading Trails from the MapXchange 
 
You can download up-to-date trail and recreation information at the MapXchange website: 
www.nationalgeographic.com/topo. 
 
All of the downloadable maps at MapXchange are provided in .tpo files that you can open, edit and save 
with your copy of Back Roads Explorer (.tpg files are provided from earlier TOPO! users). To download 
these custom maps, visit the MapXchange website, select your State or region, and follow the instructions 
to download a map file. To post your own custom map on the MapXchange site, simply create a custom 
.tpo file, visit the site and follow the instructions there to upload your custom file. 
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5.0  Accessing other Information and Getting Help 
 
There are several ways to get assistance when using Back Roads Explorer. This section provides easy ways 
to get your questions answered. 
 
 
5.1 Accessing the Map Legend 
 
1. Choose Legend from the Info menu. 
2. For USGS maps, use the pull down category list to choose a category of symbols. 
3. Place your cursor over a symbol in the legend to identify it. 
4. Click Exit to close the map legend. 
 
5.2 Status Bar Help 
 
The status bar located at the bottom of the TOPO! window is a quick and convenient way to get help while 
you are running TOPO! Notice as you move your cursor over the tools and windows that the status bar 
provides brief descriptions of commands, symbols, buttons and other parts of the screen. When your cursor 
is over the map, the status bar provides help with the tool that is currently active. Status bar help is an 
excellent way to become fluent with TOPO!’s many features. Check it frequently for tips, messages and 
help using the tools. 
 
5.3 On-Screen Help 
 
In addition to this Users Guide, Back Roads Explorer provides on-screen help for reference while you are 
using TOPO!.  From a list of topics, you can access most of the information contained in this User’s Guide. 
 
To use the on-screen help: 
 
1. Choose Help using TOPO! from the Info menu 
2. TOPO! will display an index of topics 
3. Click the topic you want to view 
 
5.4 Technical Support 
 
If you encounter system errors or are having problems using Back Roads Explorer that are not discussed in 
this manual, please contact us for assistance:  
 

1. View online support information at: www.topics -ent.com/support 
2. Or, contact us by email at helpdesk@topics-ent.com 
3. Or, call for technical assistance at (425) 656-3621. 

 
When contacting us, please describe the problem and tell us that you are using Back Roads Explorer. 
 



Back Roads Explorer User Manual (Rev. 9/03)  Page 11 of 49 

6.0  Managing Your Maps and Saving Your Work 
 
TOPO! allows you to save any information you add to the maps. The information is saved as  a .tpo file. 
 
6.1 Opening and Saving .tpo Documents 
 
A (.tpo) document is where TOPO! stores any custom information you have added to 
the maps.  Creating and saving new (.tpo) documents is easy. They can be very useful for organizing and 
sharing information. For example, you could store all your favorite mountain biking trails in a document 
named “mountainbike.tpo” and all your favorite hiking trails in a document named “hike.tpo.” If you 
wanted to give a friend your favorite mountain biking trails you could copy “mountainbike.tpo” to a floppy 
disk or e-mail it. If they owned Back Roads Explorer or the TOPO! State series of maps, they could open 
the “mountainbike.tpo” document and view, edit or print the maps with your custom trails. 
 
To open a (.tpo) document: 
 
1. Choose Open Region from the File menu. 
2. The Open File dialog box will appear displaying a list of regions that you have installed. 
3. Choose a region and click OK. 
 
(Tip: TOPO! lists the last four .tpo documents that you opened by name at the bottom of the File menu.  
From the bottom of the File menu choose the document you want to open.) 
 
To create a new region (.tpo) document: 
 
1. Choose Save As… from the File menu. 
2. Type a new name for the region document. 
3. Click OK. 
 
(Tip: To delete all the custom data you have added to a region of maps and start with a blank slate; choose 
Delete Contents… from the File menu.) 
 
6.2 Notes 
 
Using the Notes tool, you can bookmark a location and access it quickly and easily.   When you have a map 
set to the location you want to access in the future, select the NOTES tool from the toolbar and left click 
once on the map.  This will bring up an window and allow you name the note.  Next time you select the 
note, it will take you to that location.   
 
6.3 Merging .tpo Documents 
 
You can merge all custom routes, symbols, text labels, direction lines from other .tpo 
files into the .tpo file you are currently viewing. This can be useful if you have stored custom information 
in different files but wish to view all of it on the same map. 
 
To merge another region (.tpo) document into the current one: 
 
1. Choose Merge .tpo… from the File menu. 
2. The Open File dialog box will appear displaying TOPO! map documents that are available. 
3. Choose a TOPO! document (i.e. a .tpo file) and click OK. 
4. The custom objects from the .tpo file you chose in step 2 will now appear in your current TOPO! 
document. 
 
 
6.4 Deleting Custom Objects from a .tpo file 
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You can categorically delete all custom routes, symbols, text labels, direction lines and/or bookmarks from 
a region .tpo file by type of object. This can be useful if you wish to simplify a .tpo file or isolate certain 
types of custom objects. For example, you might want to share a custom map of a hike with another TOPO! 
user but first delete all the symbols in the .tpo file so as not to give away your favorite fishing spots. 
 
To delete custom objects from a (.tpo) document: 
 
1. Choose Delete Contents (New)… from the File menu. 
2. The Confirm Deletion dialog box will appear showing what types of custom objects (routes, symbols, 
text labels, direction lines, and notes) you may delete from the .tpo file. 
3. Verify that there is a checkmark in the box next to each type of custom object you wish to delete, then 
click OK. 
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7.0  Navigating and Searching the Maps  
 
TOPO!’s maps can be navigated in many ways. You can zoom in or out to see different levels of map 
detail, scroll seamlessly across map boundaries, and jump instantly to any location for which you know the 
name or coordinate. 
 
7.1 Zooming 
 
The Zoom Tool is used to change the level of detail and the scale of the map you are viewing. Map scale is 
the relationship of a distance on the map and the corresponding distance on the earth. Generally, a larger 
scale shows more detail than a smaller scale. Zoom in with the Zoom Tool to view an area of map in 
greater detail. Zoom out to see a larger area of map with less detail. 
 
To zoom using the Zoom Tool: 
 
1. Choose Zoom from the Tool menu. 
2. Position the magnifying cursor where you want to zoom in. 
3. Left click to zoom in one level. 
4. Press the shift key on your keyboard and left click to zoom out one level. 
 
(Tip: When you are using the Zoom Tool, a + symbol in the center of your cursor indicates that it is 
possible to zoom in. A - symbol in the center of the cursor indicates that it is possible to zoom out. No 
symbol in the center of your cursor indicates maximum zoom.) 
 
Variable Zoom Feature 
 
The Pop-up Variable Zoom feature allows you to magnify or reduce the map currently being viewed. It can 
be accessed while using any tool. You can magnify the current map to better view a certain area and draw 
routes with greater precision. You can also reduce the current map to get an overview of the area and view 
more of your custom work on screen. 
 
(Tip: The Variable Zoom feature changes the scale of the current map, but not the level of detail. It is 
useful for magnifying or reducing certain map areas where you are adding custom information. To change 
the level of detail, use the standard Zoom Tool.) 
 
To magnify the map using Variable Zoom Function: 
 
1. Right click on the map to access the Pop-up Zoom menu. 
2. Choose “Magnify Map” from the menu. 
3. Select one of the three “Reduce” levels (25%, 33%, 50%) to get an overview of the current map.  Select 
one of the three “Magnify” levels (200%, 300%, 400%) to enlarge the current map.   
4. Select “Normal 100%” to return to the standard scale for the current Map Level in TOPO!. 
 
(Note: When you switch Map Levels, the Variable Zoom always returns to its normal setting at 100% 
magnification.) 
 
7.2 Traveling 
 
The traveling tool allows you to move the map in any direction and travel from map to map without 
interruption. It is automatically selected when your cursor is near the edge of the map. 
 
To scroll the map with the Traveling Tool: 
 
1. Choose Traveling from the Tool menu, or simply position the cursor near the edge of the map when 
using another tool. 
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2. Position the arrow cursor in the direction you want to move. 
3. Hold the left mouse button down to begin traveling. 
4. Release the mouse button to stop traveling. 
 
(Tip: The Traveling Tool is automatically selected when your cursor is near the edge of the map. To control 
the traveling speed, move the cursor toward the edge of the map to speed up or closer to the center to slow 
down. You can also adjust the traveling speed from the Preference menu.) 
 
7.3 Centering 
 
The Centering Tool will bring any location to the center of your screen. 
 
To use the Centering Tool: 
 
1. Choose Centering from the Tool menu. 
2. Position the cursor on the map. 
3. Left click to center the cursor’s location. 
 
7.4 Overview Maps  
 
Zooming in on a small, detailed portion of a large map can be disorienting. To help you stay oriented, 
TOPO! provides two overview maps on the right side of the screen. A dark blue rectangle on the overview 
map indicates the area of map you are viewing. Notice that as you travel the rectangle’s position is updated 
on the overview maps. 
 
To navigate using the Overview Maps: 
 
1. Place your cursor over the Overview Maps on the right side of the screen 
2. A light blue rectangle will appear in place of your cursor. The dark blue rectangle represents the area 
currently on display 
3. Position the light blue rectangle over the area of map you wish to jump to 
4. Left click to jump to the light blue rectangle’s location. 
 
(Tip: To close or reopen the overview maps, click in the gray bar to their left or choose Overview Maps 
from the View menu.) 
 
7.5 Searching for Named Locations 
 
TOPO! contains a comprehensive database of place names and natural features that allows you to easily 
search the maps for a specific location. All of the information contained in the database, or Gazetteer, is 
from the USGS Geographic Names Information System (GNIS). The Gazetteer lists locations 
alphabetically or by feature type. 
 
To search for a named location: 
 
1. Choose Find (Gazetteer) from the View menu. 
2. Choose a State to search in. 
3. Choose Search All Types in this List from the search dialog box. (To narrow your search, choose a 
specific feature such as “Summit” or “Lake” to search by.) 
4. Begin typing the first few letters of the location you are looking for. To narrow your search to a 
specific geographic area, place an anchor on the map, and check the appropriate box on the find 
dialog box to limit the search res ults to within a specific distance from the anchor. 
5. Click Find Now. 
6. Click on an entry in the list to preview its location on a small overview map. 
7. Optional: To create a waypoint for location(s) in the list, select the location(s) and click Create 
waypoint(s). 
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8. To jump to the selected location, click the Go button. 
9. The location you selected will appear at the center of your screen at the intersection of the red 
cross hairs. 
 
(Tip: Explore the feature type locale for campgrounds, ski areas, and other points of interest. Use the pull 
down Go To This Map Level menu to jump to a location at a specific map scale. The coordinate pane 
displays the latitude and longitude or UTM values of locations previewed in the search dialog box. 
Locations in the gazetteer are limited to features labeled on the maps. For a list of definitions for each of 
the feature types when you are using a USGS set of maps, choose About the Maps... from the Help menu.)  
 
7.6 Searching for GPS Locations  
 
The Coor dinate Locator will find a given latitude and longitude or UTM location on the map. 
 
To search for a coordinate: 
 
1. From the View menu, choose Coordinate Locator or left click the coordinate display in the lower right 
corner of the status bar. 
2. Use the keyboard to enter the latitude and longitude or UTM values of the position you want to find. 
3. Choose the map level that you want to view the position on. 
4. Click the Go button to jump to that position on the map. 
5. The position you entered will appear at the center of your screen at the intersection of the red crosshairs. 
 
(Tip: To enter a UTM coordinate, you must set the Coordinate Display in the Preferences menu to UTM.) 
 
The Coordinate Locator can also be used to measure direction and distance between a location on the map 
and a coordinate value entered into the coordinate locator. For example, you could place an anchor point on 
a bridge and enter the coordinates of a summit, and the Coordinate Locator will report the direction and 
distance between the two locations. 
 
To determine the direction and distance to a distant landmark’s location: 
 
1. Use the Compass Tool to place an anchor point on the map, see Measuring Direction (chapter 10.0) 
2. Choose Coordinate Locator from the View menu. 
3. Enter the latitude and longitude or UTM value for the desired destination point. 
4. TOPO! will display the distance and direction from the anchor point to the new coordinate in the 
Coordinate Locator window. 
 
(Tip: The coordinate locator will measure direction and distance from a point on the map to coordinates 
that are outside of the area of coverage. This can be useful for determining which direction to look to view 
distant landmarks, such as summits.) 
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8.0  Creating and Using Routes 
 
The Route Tool is essential for measuring distance, customizing maps, building elevation profiles and 
creating GPS routes. 
 
8.1 Drawing a Route 
 
1. Choose Route from the Tool menu. 
2. Position the cursor over the map where you want the route to begin. 
3. Left-click and release the mouse to begin drawing a new route. (The pencil cursor will change from 
horizontal to an upright position to indicate that you are in drawing mode.) 
4. When your route is complete, left-click to stop drawing. 
 
For straight line segments: 
 
1. Hold down the shift key while drawing to start a straight segment. The pencil cursor icon will be 
replaced by a targeting cursor. 
2. Position the targeting cursor where you would like to end the straight line segment. (If you position the 
cursor at the edge of the screen, the map will scroll automatically) 
3. Release the shift key to end the line segment 
 
To correct a mistake while drawing: 
 
1. Hold the right mouse button down and backtrack as far as necessary to erase. 
 
(Tip: Activate the Hotspot Magnifier from the View menu to display a magnified view of the area 
immediately surrounding your cursor. This feature makes it easier to draw accurate routes or trace 
existing trails.) 
 
8.2 Displaying a Route on Multiple Map Levels 
 
Routes, like all custom objects added to the maps, can be displayed on any or all map levels. To specify 
which map levels you wish a route to be displayed on, see Appendix B, Modifying and Deleting Objects. 
 
8.3 Measuring and Displaying Distance 
 
Once you left-click to finish drawing a route, TOPO! automatically calculates the route’s distance. This 
information can be viewed temporarily or placed in a text label. 
(Tip: The distance calculated does not account for terrain and elevation changes. If you wish to determine 
the actual terrain distance, build an elevation profile. See Section 11.0 for more information on elevation 
profiles.) 
 
Displaying distance at a glance 
 
1. TOPO! will display the route distance on the status bar at the bottom of your screen when you place the 
cursor over any part of your route. 
 
Placing a text box with route distance on the map 
 
1. Display the route distance in a text label by positioning the cursor over the route and right-clicking the 
mouse. 
2. Select Add Label… from the pop-up editor. 
3. Click OK. 
 
(Tip: For more information about text labels, see 13.1 Adding Text to the Maps.) 
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Changing the distance units from miles to kilometers: 
 
You can toggle between miles and kilometers via the Preferences menu. (See Appendix C - Preference 
Settings). 
 
8.4 Extending or Shortening a Route 
 
Routes can be edited or revised using the Route Tool. 
1. Choose Route from the Tool menu. 
2. Position the cursor at either end of the route you wish to edit. 
3. When the cursor displays a “+” symbol, left click to begin editing. 
4. To extend a route, continue drawing. 
5. To shorten a route, hold the right mouse button while retracing back along the route to erase. 
6. Left-click to finish editing 
 
(Reminder: After editing routes, be sure to update any associated text labels you have placed on the map.) 
 
8.5 Splitting a Route 
 
You can take one single route and split it into two separate routes.   
1. Choose Route from the Tool menu. 
2. Right click on the location of the route where you want to split the route. 
3. Select the Split in Two function from the window. 
 
8.6 Joining Routes 
 
You can use the route tool to join together two separate routes.   
1. First select the Route from the Tool menu 
2. Left click on the end of one of the route you want to join 
3. Start drawing towards the route you want to join the first route to. 
4. When you are on top of the other route, left click once. 
5. TOPO! will ask if you want to join the two routes.  
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9.0  Using the Streets Layer 
 
Viewing the Streets Layer: 
 
To view the streets layer, click the Street Settings button on the Toolbar.  This will bring up a window, 
which will allow you to choose how you’d like the streets to be displayed. You can select the level of detail 
you’d like to see on the map, toggle the street labels on or off, and enable the “pop-up” street label feature. 
This “pop-up” feature allows you to identify street names simply by positioning your cursor over them. 
 
Adding Labels to the Streets: 
 
To add labels to the streets, click the Street Settings button on the Toolbar and check the box labeled 
“Create a text label from pop up when mouse is clicked.” If this feature is currently dimmed out, then you 
need to enable the “pop-up” street label feature by checking the box labeled “Pop up the street name when 
cursor moves over a street”. 
 
(Tip: To change the default appearance of street labels you add to the map, click the Text Style… button 
on this Street Settings dialog) 
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10.0  Measuring Direction 
 
Use the Compass Tool to measure direction and distance between any two points. Direction is described 
using the 360° in a circle (0°= north, 90°=east, 180°= south, 270°=west). 
 
10.1 True North and Magnetic North 
 
TOPO! can display directions relative to True North, the direction that most topographic maps are oriented 
toward (straight up on the map), or relative to the magnetic north pole that a compass points toward.  You 
can toggle between these two modes via the Preferences menu, (see Appendix C – Preference Settings). 
 
10.2 Radial Mode and Waypoint Mode 
 
The Compass Tool can be used in two different modes. Radial Mode is useful when you want to measure 
the direction from one location on the map to several other locations. The anchor point will remain fixed at 
point A when a direction line is created from point A to point B. Waypoint Mode is useful when you want 
to measure a series of directions along a zig zagging route (ex: from A to B, then from B to C, then from C 
to D, etc.). The anchor point will move to point B when a direction line is created from point A to point B.  
You can toggle between these two modes via the Preferences menu, (see Appendix C – Preference 
Settings). 
 
10.3 Measuring and Displaying Direction 
 
To measure direction from an anchor point to your cursor: 
 
1. Choose Compass from the Tool menu. 
2. Position the cursor where you would like to place an anchor point 
3. Left click to place an anchor point 
Once you have placed an anchor point on the map, TOPO! displays the direction and distance from the 
anchor point to your cursor in the status bar. TOPO! updates the display as you move your cursor. 
 
(Tip: Once you place an anchor point, you can move to nearby locations with the traveling cursor at the 
edge of the map or to distant locations on the overview maps. You can also switch map levels by right 
clicking on the map and your anchor point will remain fixed at its location.) 
 
To draw a direction line between two points: 
 
1. Left click the Compass Tool button on your toolbar or choose Compass from the Tools menu 
2. Position the anchor cursor where you would like the direction line to start 
3. Left click to place the anchor point 
4. Left click again at the position where you would like the direction line to end 
5. TOPO! will draw a direction line between the two points 
6. To reposition the anchor point, left click the anchor on the map or the compass tool button on the toolbar.  
After drawing a direction line, TOPO! will display the line distance and azimuth in a pop-up text box and 
on the status bar when you place the cursor over the direction line. 
 
To display direction in a text label on the map: 
 
This is achieved in the same manner as displaying distance (see 8.3 Measuring and Displaying Distance). 
 
(Tip: To toggle between true north and magnetic north, choose Direction Reference from a direction line’s 
pop-up option menu (see Appendix A Pop-up Editors), or toggle the overall preference setting via the 
Preferences menu (see Appendix C Preference Settings). To build a profile or change the appearance of a 
direction line, use the options menu (see Appendix A Pop-up Editors).) 
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10.4 Placing an Anchor Point on Top of Other Custom Objects  
 
You can place an anchor point on top of other routes, symbols, text labels or direction lines without 
selecting the custom object below. This can be useful if you wish to set the anchor for a direction line on a 
specific location on the map where you have already placed a custom object. 
1. Choose Compass from the Tool menu. 
2. Hold down the “Ctrl” key. 
3. Move the cursor over the object and place the anchor for the direction line. 
4. Release the “Ctrl” key. 
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11.0  Building and Understanding Elevation Profiles 
 
TOPO! can generate an Elevation Profile for any route you trace on the map. An elevation profile is a 
graphic representation of the vertical gain and loss along a route. Elevation profiles can show the following 
statistics for a route: total gain, total loss, net gain, average grade, and true overland distance. Elevation 
profiles can be printed, copied, and saved to disk for use in other applications. 
 
11.1 Building Elevation Profiles 
 
Once you have drawn a route, you are ready to build an elevation profile. The Build Profile, command 
located in the pop-up editor, will generate the profile. (See Appendix A for more on Pop-up Editors) After 
drawing a profile, TOPO! displays the route’s statistics in the profile window.  Interactive features in the 
profile window allow you to identify where a point on the profile is located on the map, zoom in on a 
specific section of the profile, and change the scale of the profile. 
 
To use the Build Profile command: 
 
1. Draw a route using the Route Tool , (see 8.1 Drawing a Route ). 
2. Choose the route by placing your cursor over it. 
3. Right-click the mouse to access the route’s pop-up editor, then choose Build Profile (see Appendix A 
Pop-up Editors). 
4. TOPO! will gather data and display the profile in the elevation profile window. 
5. To close the elevation profile pane, grab the top of the pane and drag it down (or de-select Elevation 
Profile from the View menu). 
 
(Tip: Elevation profiles can be built from routes, direction lines and GPS routes. To avoid confusion, be 
sure the cursor is over the correct route line when constructing a profile. When using the Waypoint Tool, 
only waypoints and GPS routes can be selected. Use any other tool to select a freehand route drawn with 
the Route Tool.) 
 
11.2 Understanding the Profile and Profile Statistics 
 
The elevation profile is a graph; it shows the vertical gain and loss along the course of the route on the map. 
The vertical axis shows elevation in feet or meters above sea level; its units run along the left edge of the 
profile. The horizontal axis shows distance from the start of the route in miles or kilometers; its units run 
along the bottom edge of the profile. Blue and green color bands indicate fixed units of elevation that vary 
from profile to profile depending on the amount of elevation change. 
The following statistics about the route are displayed below the profile: 
 
• Total gain: displays the sum of all the uphill segments along the route. 
• Total loss: displays the sum all the downhill segments along the route. 
• Net gain: displays the difference in elevation between the end and the start of the route. 
• Terrain distance: is displayed in the status bar when your cursor is over the profile window. It shows a 
distance from a route’s start point to your cursor that includes the ups and downs along the route in addition 
to the horizontal distance. Because terrain distance includes this vertical change as well as the horizontal 
change, terrain distance more accurately reflects the true length of a route. 
• Vertical Exaggeration: is a number that reflects the ratio between the vertical scale (elevation) and the 
horizontal scale (distance) of a profile. It is displayed as a number followed by an x. It describes how much 
a profile has been stretched to fit the elevation profile window. For example: an exaggeration of 4X means 
that hills along the profile appear four times steeper than they actually are. 
 
(Tip: If a route’s net gain is positive, the route ends at an elevation that is higher than the elevation where 
it began; if negative, the route ends lower than where it began. It is possible to determine the grade of a 
section of profile by selecting and viewing it in greater detail, see below, Zooming in on a profile and 
determining average grade.) 
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(Tip: To change between feet and meters or miles and kilometers, use the Preference menu. See Appendix C 
Preference Settings.) 
 
11.3 Viewing Profile Details 
 
Identifying Points along the Elevation Profile on the Map 
 
As you move the cursor over the profile, horizontal and vertical guides will appear to help identify the 
distance and elevation of a particular point along the profile. Clicking on the profile will identify 
corresponding locations on the profile and on the map. 
 
To identify a location on the map that corresponds with a point on the profile: 
 
1. Click on the profile at a point you wish to identify. 
2. TOPO! will place two yellow dots; one on the map and one on the profile. 
3. These yellow dots represent corresponding locations. 
4. Each time you click, TOPO! will update the yellow dots and display the distance from the start of the 
route to the yellow dot. 
 
To label a point on the profile and map: 
 
When TOPO! builds a profile, any waypoints along the route are displayed in the profile. Use the 
Waypoint Tool (see  14.3 Creating Waypoints on the Map) to place waypoints on the map anywhere 
you want along the route. Then build a profile. 
 
Zooming in on a profile and determining average grade: 
 
After building a profile, you can select a portion of it to view in greater detail. TOPO! will display the 
average grade for the selected area. The average grade is a percentage that reflects the ratio of the total 
amount of elevation change to the total horizontal length of the selected portion of route. For example, a 
section of route that climbs 3000 feet and drops 2280 feet in the course of 5 miles would have an average 
grade of 20% (total elevation change=3000+2280=5280 feet= 1mile divided by five miles = 20%). 
 
To view a portion of profile in greater detail: 
 
1. After building a route, left click on the Magnifier button in the right corner of the elevation profile 
window. 
2. The elevation profile will split into two panes. 
3. The right pane displays the entire profile, with a selected area defined by two red vertical lines. 
4. The left pane displays the selected area in greater detail. 
5. The average grade of the selected area is displayed in the left pane. 
6. To change the selection area, grab either of the red selection bars in the right pane and drag; or click 
outside of the selection area. 
7. Resize the elevation panes by grabbing the splitter bar that separates the left and right panes and 
dragging. 
8. Click the magnifier button to close the magnification pane and view the entire profile. 
 
Resizing the Profile Window to Fill Your Screen 
 
When elevation profiles are built, they are scaled to fit in the profile window. To see the entire profile in 
greater detail, grab the horizontal splitter bar that separates the map and profile windows and drag it up to 
fill your screen. 
 
(Tip: Resizing the profile window changes the size of printed and exported profiles.) 
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11.4 Printing, Copying, and Exporting Elevation Profiles 
 
Elevation profiles can be printed with a map or independently, copied to the clipboard, and saved to disk 
for use in other applications. 
 
To print an elevation profile with a map: 
 
1. Build a profile of a route (see  11.1 Building Elevation Profiles). 
2. Select the Print Tool and the Print tab. 
3. Check the Elevation Profile box among the Print Options at the lower right corner of your screen. The 
active profile will automatically be printed with your map. (See Chapter 12 for more on printing maps). 
 
To print an elevation profile without the map: 
 
1. Build a profile of a route (see  11.1 Building Elevation Profiles). 
2. From the File menu, choose Print Profile. 
3. Set the options and choose OK to print. 
 
To copy an elevation profile to the clipboard or export it to disk: 
 
1. Build a profile of a route (see  11.1 Building Elevation Profiles). 
2. From the File menu, choose Copy Profile or Export Profile to Disk... 
 
(Tip: Profiles saved to disk are for use in other applications. They cannot be reopened in TOPO!. To use a 
profile again later, rebuild it from the route.) 
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12.0  Printing, Copying and Exporting Maps  
 
Most of the maps in TOPO! are much larger than a printed page. The Print Tool allows you to easily 
define an area of map for printing or copying to the clipboard. Maps can be printed in color or black & 
white, and will automatically include any custom symbols, text, routes, grids and GPS data you have added.  
Once you have selected the Print Tool , the right side of your screen will display a Print Preview Pane and 
a menu of setup, printing, and exporting options. These options can be used to customize your printed map. 
 
12.1 Quick Guide to Printing 
 
1. Choose Print from the Tool menu. A red rectangle with an “X” through its center will appear on the 
map. This rectangle shows the current Selection Area: its size defaults to the amount of map that will 
exactly fit on the printed page. 
2. Left click on the map at the center of the area you wish to print. (You can also drag the Selection Area 
rectangle around on the map to adjust the print boundaries.) 
3. Click the Print Map button at the lower right portion of the screen. 
 
(Tip: If you are not printing on a color printer, go to the Preferences menu and select the Print Tool 
submenu. Then select Output to Grayscale. This setting will give you the best output to a black & white 
printer.) 
 
12.2 Selecting an Area of Map to Print 
 
When you select the Print Tool , a red rectangle with an “X” through its center will appear on the map.  
This rectangle shows the current Selection Area: its size defaults to the amount of map that will exactly fit 
on the printed page. This is indicated by a checked box called Select 1 Full Page that appears in the print 
options at the right side of the screen. To print a full page map, make sure this box is checked. The 
selection area can be moved by clicking on a new center point on the map or grabbing and dragging a side. 
 
Printing less than one full page 
 
1. Un-check the “Select 1 Full Page” box found on the right side of your screen among the Print Options. 
2. Redraw the Selection Area to your specifications by placing the cursor at one corner of the desired area 
and holding down the left mouse button while dragging the mouse to draw a new rectangle. 
 
12.3 Using the Print Preview Pane 
 
The Print Preview pane lets you review the boundaries of the Selection Area before you print. Once you 
have defined your Selection Area, refer to the Print Preview pane in the upper right corner of your screen.  
The red rectangle and “X” represent the portion of map that will be printed. The white rectangle 
background represents the sheet of paper in the current printer. (Note: To switch printers, change margins 
or paper orientation, click on the Page Setup... button). 
 
To review the boundaries of the selection area: 
 
1. The dark blue rectangle in the Print Preview pane indicates the portion of the Selection Area currently in 
view on-screen. 
2. Move the cursor within the Print Preview pane. A light blue rectangle and targeting circle will appear. 
3. Left-click to center the main-screen map display on the point indicated by the light -blue targeting circle. 
Target the boundaries of your Selection Area to confirm that the selected area is what you want to print. 
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12.4 Page Setup Options: Printer Type, Paper Size, Orientation, Margins 
 
Left clicking the Page Setup... button will open the Page Setup screen, displaying current specifications for 
paper size and source, as well orientation and margins. To select a printer other than the current default 
printer, select the Printer…button in the lower right corner of the Page Setup screen. Left click on the 
arrow on the right side of the Printer pull-down bar to select a printer from the available options.  Maps can 
be printed in either a Portrait or Landscape configuration by selecting the appropriate option on the Page 
Setup screen.  �Margin specifications are also displayed on the Page Setup screen. To change any margin, 
click on the current measurement to highlight it, then type in your new specifications. 
 
12.5 Adjusting the Magnification of the Printed Map 
 
Magnification of the print area can be adjusted to blow up or reduce a selected area of map. The 
Suggested setting will print your Selection Area at 50% magnification. This should give the best results on 
most color ink jet printers.  Use the Custom setting to achieve any of the following results:  
  
• To increase the magnification of the map, click the Custom... magnification button, then enter a 

scaling factor of 75%, 100 %, or even larger. 
 
• To reduce the magnification of the map, click the Custom... magnification button, then enter a 

scaling factor of 40% or even smaller. 
 
• To get an exact area defined on the map to expand or shrink to fit a page, click the Custom... 

magnification button, then choose Magnify or reduce selected map to exactly fit 1 page. 
 
12.6 Including Headers, Elevation Profiles and other Reference Data 
 
The Include section in the lower right corner of the Print Options pane allows you to choose the marginalia 
that will be printed around the borders of your map. 
 
(Note: Data elements selected for inclusion will only appear on your print, not on the screen.) 
 
• Check the Scale Bar box to include a distance scale reference bar in your print. 
 
• North Arrow will place an indicator on your print identifying both true and magnetic north. 
 
• The Grid Labels option will print the latitude and longitude or UTM coordinates of the grid lines 

along the edges of the printed map. If you have chosen not to include grid lines on your map, TOPO! 
will print the coordinates of the four corners of your print area instead. 

 
• Selecting the Header... check box will include by default the TOPO! region file from which a map 

comes, as well as the date. To modify the header, double-click the left mouse button on the 
Header... checkbox. This will display the full text of the current header, which can then be edited or 
changed.  

 
• Check the Elevation Profile box to include a profile below the printed map. If you have not yet built 

a profile for the desired route (or if you have built other profiles since then), build a profile before 
printing (see  11.1 Building Elevation Profiles). 

 
12.7 Copying and Exporting Maps  
 
Individual map selections can be copied and pasted into other applications, or exported to disk for use in 
other programs. 
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Copying a map to the clipboard 
 
1. Define your Selection Area using the Print Tool (see  12.2 above). 
2. Choose Copy Map from the File menu to copy the current Selection Area to your computer’s clipboard. 
The map can then be pasted into documents, graphics files, etc. (in accordance with the terms of the User 
Agreement). 
 
Exporting maps  
 
1. Define your Selection Area using the Print Tool (see 12.2 above). 
2. Choose Export Map to Disk… from the File menu to save the current Selection Area to disk for 
attachment to e-mail or for use in other applications. You will have the option to specify the graphics file 
format in which you would like the map saved (i.e.: .bmp, .jpeg, .gif, .tiff, etc.) 
 
(Note: Maps saved as graphics files are for export to other applications and cannot be opened again in 
TOPO!.) 
 
12.8 Suggestions for Maps Too Large to Print on a Page 
 
There are many ways to get a large map in TOPO! to print using the smaller size of paper that your printer 
accepts. Here are 4 different methods you can try: 
 
Method 1:   Select the Custom magnification option, then choose Magnify or reduce selected map to 
exactly fit one page. This will let you define the exact map boundaries of the area you would like to print, 
and TOPO! will scale that area to fit on a single page. 
 
Method 2:   Use the Custom magnification option to select a print scale of 40% or even smaller. This will 
enable you to select a much larger portion of map. Also remember to check the 
Select 1 full page option so that your map will not get cropped at the edges. 
 
Method 3:   Zoom out and try printing the region from a smaller scale map. For example, if you are 
trying to print a large portion of a 1:24,000 scale map, see if printing the same region 
from a scale of 1:63,360 will give enough detail for your needs. 
 
Method 4:   Print a large map in several tiled sections. To do this, check the Select 1 full page box, then 
position the Selection Area so that it includes the top left portion of the map that you are tiling. Print 
Map, then use the Move Selection Boundaries command in the Print Tool submenu of the Preferences 
menu to move the red rectangle north, south, east, or west exactly one page. Print the new section of map 
and it will join the first map perfectly. Continue this process for as many pages of map that you need. 
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13.0  Customizing the Maps with Text, Symbols and Routes  
 
TOPO! makes it easy to create custom maps. Use the text, symbol , and drawing tools to annotate the 
maps. The pop-up option menu lets you customize an object’s color, font, size, width, etc. All information 
you add can be easily saved and deleted. Information you add to the maps is included on TOPO! printouts 
and exports. 
 
13.1 Adding Text to the Maps  
 
Use the Text Tool to add text labels to the map. After creating a text label, you can edit how the text 
appears using the pop-up option menu. Text labels can be easily moved and deleted. 
 
To use the text tool: 
 
1. Choose Text from the Tool Menu. 
2. Position the cursor and left click on the map. 
3. Enter text in the text dialog box and click OK. 
4. TOPO! will place the text label at your cursor’s location. 
 
To move a text label: 
 
1. Choose a text label by positioning your cursor over it. 
2. Hold down the left mouse button and drag. 
 
To change the appearance of a text label: 
 
1. Choose a text label by positioning your cursor over it. 
2. Click the right mouse button to access the pop -up editor, (see Appendix A Pop-up Editor). 
3. To edit a text label, change the text. 
4. To change the size or font of the text, choose Modify Style 
5. To change the color of the text, choose Modify Style 
6. To change the background color, select the Backdrop pop -down menu. 
 
To copy and delete text labels: 
 
See Appendix B Modifying and Deleting Objects. 
 
13.2 Adding Symbols to the Maps  
 
Use the symbol tool to add symbols to the map. TOPO! contains a library of symbols to choose from.  
Symbols can be easily moved or deleted after they have been placed. 
 
To use the Symbol Tool: 
 
1. Choose Symbol from the Tool menu. 
2. Position the cursor and left click on the map. 
3. TOPO! will place the default symbol at your cursor’s position. 
 
To move a symbol: 
 
1. Choose a symbol by positioning your cursor over it. 
2. Hold down the left mouse button and drag. 
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To copy and delete symbols: 
 
See Appendix B Modifying and Deleting Objects . 
 
13.3 Changing the Color and Style of Symbols and Routes 
 
To change a symbol’s icon or color: 
 
1. Choose a symbol you have placed on the map by positioning your cursor over it. 
2. Right click to access the symbol’s pop-up editor. 
3. Select a new symbol or color from the Modify Style button. 
 
(Reminder: When a symbol is “chosen,” TOPO! replaces your cursor with the pop-up option menu cursor 
that is shaped like a hand.) 
 
To change the color or style of a route: 
 
1. Choose a route you have drawn on the map by positioning your cursor over it. 
2. Right click to access the pop-up editor. 
3. To change the color of the route, select Modify Style. 
4. To change the width of the route, select Modify Style. 
5. To choose what levels a route is displayed on, select Modify Style. 
 
To add routes to the map: 
 
See  8.1 Drawing a Route. 
 
To edit routes: 
 
See  8.4 Extending or Shortening a Route . 
 
To copy and delete routes: 
 
See Appendix B Modifying and Deleting Objects. 
 
13.4 Placing Text and Symbols on Top of Other Custom Objects 
 
You can place text and symbols on top of other routes, symbols, text labels or direction lines without 
selecting the custom object below. This can be useful if you wish to place a text box or symbol in a specific 
location on the map where you have already placed a custom object. 
 
1. Choose Text or Symbol from the Tool menu. 
2. Hold down the “Ctrl” key. 
3. Move the cursor over the object and place the Symbol or Text box. 
4. Release the “Ctrl” key. 
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14.0  Customizing the Maps with Waypoints and Grids  
 
TOPO! provides a powerful set of navigational tools that can help you plan a trip on-screen and customize 
printed maps to keep you oriented in the backcountry. Drawing your intended route on the map ( 8.1 
Drawing a Route) and building an elevation profile of it ( 11.1 Building Elevation Profiles) will give you 
a good sense of how difficult the trip will be and how much time you should budget for it. Including a scale 
bar and north arrow on your custom print outs ( 12.6 Including Reference Data) will make it more useful 
for compass navigation. The focus of this chapter is on yet another set of navigational aids that can make 
your printed maps easier to use in the field: waypoints and grids. 
(Note: If you use a GPS receiver, you’ll benefit from reading both this chapter and the next. Even if you 
don’t have a cable to link your GPS to your computer, including waypoints and grids on your printouts 
will allow you to use the coordinates reported by the GPS receiver to pinpoint your position on the map.) 
 
14.1 Determining Location and Reading Coordi nates 
 
Coordinates are the numbers (and/or letters) that precisely describe positions on the Earth. As you move the 
cursor over the map window, TOPO! displays the cursor’s coordinates in the status bar at the lower right 
corner of your screen. TOPO! lets you display these coordinates in either of two coordinate systems: 
latitude / longitude or UTM (switch from one to the other via the Preferences menu). 
 
Latitude / longitude coordinate system: 
 
The latitude / longitude system is the most common coordinate system in use today. Latitude describes how 
far north or south of the equator a location is; lines of latitude, circles that are parallel to the equator and to 
one another, are also called "parallels." Longitude describes how far east or west of the Prime M eridian 
(Greenwich, England) a location is; lines of longitude, half-circles that extend from the north pole to the 
south pole, are also called "meridians."  A position in the latitude / longitude system is described as being 
the intersection of a line of latitude and a line of longitude. Latitudes go from 0° at the equator to 90°N at 
the North Pole and from 0° at the equator to 90°S at the South Pole. Longitudes start at 0° at the Prime 
Meridian and run west to 180°W and east to 180°E (where they meet). The latitude is usually listed first, 
then the longitude, as in: 37.76417°N, 122.41194°W. This example was given in decimal degrees, but the 
same position could be given in degrees and decimal minutes as: 37°45.850'N, 122°24.717'W, or in 
degrees, minutes, seconds as: 37°45'51"N, 122°24'43"W. When using TOPO! with a GPS receiver, be sure 
to set both of them to display in the same 
format. 
 
UTM coordinate system: 
 
UTM, or Universal Transverse Mercator, is another commonly used coordinate system, especially for 
navigating on land. Instead of referencing imaginary grid lines on the globe, UTM projects sections of the 
globe onto a flat surface. Each of the 60 sections, called zones, cover 6° of longitude. UTM zones start with 
zone number 1 which lies between longitude 180° (the International Date Line) and longitude 174°W and 
run east to zone 60. 
 
A UTM position is described by three elements: the zone it is in, an easting value, and a northing value.  
Eastings and northings measure how far into a zone a position is in meters. Eastings are an east/west 
measurement that corresponds to longitude. Northings are a north/south measurement that corresponds to 
latitude. By comparing two UTM positions that are within the same zone, you can determine how far apart 
they are on land (the difference in their eastings tells you how far east in meters one position is from the 
other; the difference in their northings tells you how far north in meters one position is from the other). 
 
Reading coordinates in TOPO!: 
 
Look in the lower right corner of the status bar to find coordinate information. By default, coordinates are 
displayed in degrees, minutes, seconds using the latitude / longitude coordinate system. The default datum 
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is the North American Datum of 1983 (NAD83). This datum is essentially equivalent to WGS84, used by 
most GPS receivers. Unless you have a specific need to change the datum, you should leave it on its default 
setting. Elevation appears to the right of the coordinates and is given in feet or meters above mean sea level 
in the North American Vertical Datum of 1929. 
 
(Tip: Use the Preference menu or right click on the coordinate display to change the coordinate style.) 
 
14.2 Using the Coordinate Locator 
 
See 7.6 Searching for GPS Locations. 
 
 
14.3 Creating Waypoints on the Map 
 
The Waypoint Tool makes it easy to use TOPO! with your GPS receiver. Waypoints placed on the maps at 
key locations such as trailheads, water sources and backcountry destinations provide the information a GPS 
receiver needs to guide you to those p laces. Waypoints can also serve as common points of reference if you 
print multiple maps at varying scales.  Waypoints placed on the map automatically store the coordinates of 
their location. They can be named and labeled with text messages and have a date/time stamp indicating 
when they were created. Waypoints can be used singly to mark a trailhead or other landmark point, or they 
can be used in combination to help guide you from point to point along a trail or across open wilderness. 
Once these waypoints have been created, they can be programmed into your GPS receiver for easy 
navigation. Conversely, waypoints and landmarks logged in the field with your GPS receiver can later be 
entered and stored as waypoints in TOPO!. 
 
Placing a New Waypoint: 
 
1. Choose Waypoint from the Tool menu. 
2. Move the cursor to the point on the map you wish to mark. 
(Note: As you move the cursor, its coordinates are displayed in the bottom right corner of your screen.) 
3. Left click to place a Waypoint . 
4. Once you have placed the point, the TOPO! Waypoint Editor will appear onscreen. The Editor can be 
used to name the current waypoint (TOPO! will number them sequentially by default), adjust the 
coordinates and elevation of the waypoint, and record the time and date the waypoint was created. You will 
also have the option to include a brief text message along with the other waypoint information. 
 
(Note: Waypoints placed on maps are not stored in the Region (.tpo) document, but in their own GPS (.tpg) 
document. This allows you to share GPS data between different region documents. See  14.9)  
 
Managing Waypoints and Routes 
 
Waypoints can be placed most accurately when maps are viewed at the most detailed magnification level 
(see  7.1 Zooming). Once you have placed a waypoint on the map , it will be visible on every magnification 
level. To change how it appears, see  14.5 Modifying the Waypoint Labels below. 
 
14.4 Moving and Editing Waypoints. 
 
Waypoints can be moved most easily by dragging them on the map. If you want to edit a waypoint's 
coordinates, name, or elevation, open its Waypoint Editor: 
 
1. Choose Waypoint from the Tool menu. 
2. Position your cursor over the waypoint and right click. 
3. Select Properties… from the pop -up editor. 
4. This will open the Waypoint Editor , where you can edit the waypoint's properties. 
5. Click OK to apply any changes you've made to the waypoint. 
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14.5 Modifying the Waypoint Labels 
 
Waypoint Labels can include as much or as little information as you would like. 
 
To specify what information will be displ ayed in your waypoint labels: 
 
1. Select the Preferences menu from the menu bar. 
2. Select the Waypoint Labels sub-menu. You can choose to have labels display Name Only, 
Coordinates Only, or Both Name and Coordinates, or you can select to Hide Labels, leaving the point 
marked with just the Waypoint symbol. 
The Waypoint Labels sub-menu also offers the choice between having Backdrops On or Backdrops Off.  
Backdrops highlight Waypoint Label information, making label text stand out on the page. However, if you 
find that other useful information is being obscured by these backdrops, you may prefer to leave them off. 
 
(Tip: If you plan to use your printed map with a GPS receiver, set the Waypoint Labels to display Both 
Name and Coordinates and place waypoints at any locations you might wish to visit. You'll then have the 
information your GPS needs to guide you when you're out on the trail.) 
 
To change coordinate style and datum: 
 
Waypoints can be displayed using either a latitude/longitude or UTM coordinate system.  When using the 
latitude/longitude style, you can choose between displaying coordinates in decimal degrees, or degrees and 
decimal minutes, or degrees minutes and seconds. You can also specify whether coordinates should be 
referenced to the NAD27 or NAD83 / WGS84 datum. To change any of these settings, choose Coordinate 
Display in the Preferences menu. 
 
(Note: Changes to Waypoint appearance and datum preferences affect ALL waypoints in your file. These 
changes will appear on all magnification levels automatically.) 
 
Modifying Individual Waypoint Labels 
 
Text Labels can also be placed alongside standard Waypoint Labels to provide additional information 
about a particular waypoint: 
 
1. Choose Waypoint from the Tool menu. 
2. Position your cursor over the waypoint and right click. 
3. Select the Create Text Label option. This Text Label will initially include the waypoint name and 
coordinates, along with any text message you specified when creating the point. You can also enter your 
own text in addition to or instead of this information. 
 
(Note: Once a Text Label has been placed, it becomes static text. If you move or modify the waypoint, the 
Text Label will not automatically move or change correspondingly.) 
 
14.6 Using Grids  
 
Grid lines on a printed map allow you to easily identify your position when you obtain your coordinates 
from a GPS receiver. TOPO! can provide either latitude/longitude or UTM coordinate reference data, 
scaled to your specifications. Once activated, your grid lines will automatically appear on printed maps.  
 
To add grid lines to any map: 
 
1. Select Grid… from the View menu. The TOPO! Grid Wizard will appear. 
2. Use the Grid Wizard to Choose a grid type (Lat/Long or UTM) and interval (in seconds or meters, 
accordingly). 
3. Next, Specify the map level that should display this grid. 
4. Finally, Pick a color for the grid lines. You may also specify solid or dashed lines. 
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5. Click Finish to apply the grid lines to your map. 
 
(Note: To change map datum or coordinate display settings, select the Preferences menu from the Menu 
Bar at the top of the screen. Then select the Coordinate Display sub-menu and change preferences as 
desired.) 
 
To identify your position on a printed map using the grid lines: 
 
1. Use a GPS receiver to determine the coordinates of your current position. 
2. Find the grid lines for the latitude and longitude (or UTM easting and northing) that most closely match 
the coordinates you found in step 1, and follow those two lines to where they meet. 
3. Your position on the map is near the intersection of the two lines. 
4. For more accuracy, determine whether the coordinates of your position are above or below the latitude 
(or northing) grid line, and left or right of the longitude (or easting) grid line. This allows you to identify 
the grid “box” your position lies within. Estimate your position within the box by comparing how far the 
four bounding grid lines are from the coordinates obtained in step 1. 
 
(Tip: Using a grid spaced at a narrow interval (such as 10 seconds or 100 meters) makes it easier to 
determine your location on the map when using a GPS. It also allows you to better estimate the coordinates 
of places on the map when you’re in the field and want to create waypoints. Try using dashed lines to allow 
more map to show through.) 
 



Back Roads Explorer User Manual (Rev. 9/03)  Page 33 of 49 

15.0  Using Back Roads Explorer with a GPS Receiver 
 
TOPO! is a great complement to GPS receivers. This chapter begins with a brief introduction to GPS and 
some of the common terminology associated with it. The sections following that explain how to creat e GPS 
waypoints and routes on TOPO!’s maps, connect your PC to your GPS receiver, and upload (export) that 
information to the GPS. You’ll also learn how to download (import) information you’ve collected with 
your GPS receiver and see it on TOPO!’s maps. If you have a laptop PC, you might want to try connecting 
it to your GPS to track your position while someone else is driving (see section 15.7). The final sections 
explain how to manage GPS data in TOPO!, how that data is stored on the hard drive, and how t o share that 
data with other software applications. 
 
 
15.1 A Quick-Start Guide to GPS 
 
“GPS” stands for Global Positioning System. It consists of a network of 24 orbiting satellites that transmit 
precisely timed radio signals, ground stations that control those satellites, and handheld GPS receivers that 
use the radio signals to calculate your position on the earth. Most handheld receivers on the market today 
will “lock on” to the signals needed from at least 3 satellites and display the coordinates of your position 
within a minute of turning it on outdoors. If you are moving, the GPS receiver will also report your heading 
and speed. If you have entered waypoints into its memory, the receiver can report how far away those 
locations are and in what direction. Properly used, a GPS receiver can help guide you to your destinations 
without getting lost. 
 
To navigate to places you have never been before with your GPS, you need to create waypoints for 
those places in advance, and to do this, you need the coordinates (latitudes and longitudes) of those 
places.  TOPO! is the easiest way to plan your GPS adventure -- just click on the map and TOPO! 
will display the coordinates for you.  
 
Coordinates: 
 
Coordinates are the numbers (and/or letters) that precisely describe positions on the Earth. For more 
information about coordinates and coordinate systems, see 14.1 Determining Location and Reading 
Coordinates . 
 
Waypoints: 
 
When a location’s coordinates are assigned a name and stored in TOPO! or in a GPS receiver, it becomes a 
“waypoint.” As Michael Ferguson, author of GPS: Land Navigation, points out, a waypoint “is not a 
physical location on the ground, but rather the coordinates that approximate that location.” The actual 
locations of waypoints created in TOPO! will usually be within 25 meters of where they appear to be on the 
map. Most GPS receivers today, however, are only accurate to about 100 meters. When you arrive at your 
destination, your GPS might still report that you have up to 0.05 miles to go. 
 
(Note: Some Magellan receivers use the term “landmark” in the place of “waypoint.”) 
 
Routes and Legs: 
 
Most handheld GPS receivers also support “routes.” A route is a series of waypoints that have been linked 
in a certain order into a sequence of “legs.” A leg is a straight segment going from one of the waypoints of 
the route to the next. (A route consisting of 3 legs will therefore have 4 waypoints.) Using routes makes it 
easier to navigate with your GPS when you intend to pass through several waypoints, because your GPS 
will automatically switch to the next leg when you arrive at the previous leg’s destination waypoint. To 
learn how to create GPS routes in TOPO!, see section 15.3 below. 
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Tracks: 
 
Another common feature of handheld GPS receivers is the ability to automatically keep track of where 
you've been while using the GPS. The coordinates of the last thousand or more positions are stored in a 
“track log” in the receiver’s memory, and are often displayed on the GPS screen as a series of bread crumb 
dots indicating the course you've taken. Most receivers that support tracks let you set the time and/or 
distance interval between successive track points. If you're using the GPS in a car, you might want to 
record your position every 30 seconds; on foot, you might only want a point every 2 minutes. To learn how 
to import your GPS track log into TOPO! to see where you’ve been on the map, see section 15.6 below. 
 
15.2 Creating Waypoints 
 
To use your GPS to navigate to places you have never been, you need to create waypoints for those places 
in advance. At the very least, you'll probably want to make a waypoint for the trailhead (or start of your 
trip) and one for your final destination. In addition, you may wish to mark locations that you'd like to stop 
at along the way (summits, lakes, stream crossings, water sources, etc.), or major trail or road intersections 
along your route. To learn how to create waypoints in TOPO!, see 14.3 Creating Waypoints on the Map. 
 
15.3 Creating GPS Routes 
 
A GPS route is a series of waypoints that are arranged in the order that you intend to travel. Each route you 
create in TOPO! will appear as a separate folder in the Waypoint List (see section 15.8 below). This 
section will describe three different methods for creating routes in TOPO!. 
 
(Note: When a GPS route is “active,” it will appear red on the map and in the Waypoint List. Any new 
waypoints you place on the map will be added to the end of an active route. Inactive routes appear blue.) 
 
To create a GPS route from a freehand route drawn with the Route Tool: 
 
1. Use the Route Tool to draw a route (see 8.1 Drawing a Route .) 
2. Once your route is complete, position the cursor over the route and right-click the mouse to access the 
pop-up option menu. 
3. Select Create GPS Route… from the pop -up options. This will bring the TOPO! Route Wizard up on 
your screen. 
4. You will have the option to enter a Prefix for New Waypoints. This prefix, plus a number for each 
sequential waypoint, will serve as the “name” for your GPS waypoints. 
5. Next, select the Number of New Waypoints to Create along Route. 
6. Left-click Finish to create your GPS route. 
 
(Note: Routes created with the Route Wizard will consist of a set of evenly spaced waypoints. You can edit 
such a route by dragging its waypoints to other locations on the map, deleting some of its waypoints, 
and/or inserting new waypoints by clicking on one of its legs.) 
 
To create a GPS route by clicking down waypoints on the map: 
 
1. Choose Waypoint from the Tool menu. 
2. Choose New Route… from the GPS menu. This will create an empty folder in the Waypoint Lis t, and it 
will be red, meaning that it is active and ready to have waypoints added to it. 
3. Position your cursor over the start of your intended route and left click to place the first waypoint. Give 
the waypoint a name and click OK to place it on the map. It will become part of the active route you 
created in step 2. 
4. Move your cursor to the next location that you'd like to place a waypoint and left click. This waypoint 
should be displayed with a red line connecting it to the previous waypoint in your route. 
5. Continue to place as many waypoints along your route as you want, up to the maximum allowed by your 
GPS receiver. 
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(Note: If a route is active (red) when you create new waypoints on the map, those waypoints will 
automatically be added to the end of that active route. To remove a waypoint from a route, right-click on 
the waypoint and choose Cut… To place waypoints on the map that do not belong to any routes, first 
deactivate all routes by selecting Close Routes (Deactivate) from the GPS menu.) 
 
To create a GPS route from a set of existing waypoints: 
 
1. Select the waypoints from the Waypoint List that you wish to include in the new route. Hold the Ctrl 
key down while you left-click each desired waypoint. 
2. Right-click on one of the highlighted waypoints in the Waypoint List and choose Copy from the pop-up 
option menu. 
3. Select New GPS Route from the GPS menu. A red empty folder will appear in the Waypoint List. 
4. Right-click on the red “Empty” folder icon and select Paste from the pop-up option menu. TOPO! will 
automatically create a route linking them. 
 
(Note: The order in which waypoints are copied from the Waypoint List will determine the order in which 
they appear in your route. Route sequence can be altered by cutting and pasting to adjust the order in 
which waypoints appear in your route folder. Waypoints get pasted after the waypoint that is currently 
highlighted. To paste a waypoint at the beginning of a route, highlight the folder icon for the route itself.) 
 
15.4 Connecting to a GPS Receiver 
 
Connecting TOPO! directly to your GPS receiver is easy. A direct connection allows you to automatically 
send waypoints and routes you have created in TOPO! to your receiver so that you can later navigate to 
those places using the GPS. A direct connection also allows you to download waypoints, routes, and tracks 
of places you have been from your receiver directly onto TOPO!’s maps. If you have a laptop computer, 
you can also use the direct connection to see your current location continuously updated on a moving map 
display. 
 
(Note: Connecting requires a GPS receiver that supports PC upload/download and a compatible PC cable, 
available from GPS retailers or manufacturers -- contact National Geographic Maps for help locating a 
dealer near you.) 
 
Setting up TOPO! and your GPS receiver for connecting 
 
1. Attach one end of your PC cable to your GPS receiver and the other to an available communications port 
on your PC. (See your GPS receiver manual and your PC manual for more information about cable 
connections and communication ports.) 
2. Power on your GPS receiver. 
3. If you are using a Garmin GPS, check that your receiver’s Interface mode is set to “Garmin” or 
“GRMN/GRMN.” (See your Garmin manual for more information about setting the Interface mode.) 
4. In TOPO!, choose Change GPS Settings... from the GPS menu. The GPS Setup screen will appear. 
5. Choose your GPS manufacturer and model from the pull down menus. If you do not see your specific 
model in the pull down menu, choose (None of the Above ). (If you do not see your manufacturer in the 
pull down menu, you can select one of the NMEA options and use TOPO! with a laptop for live 
tracking; visit our web site at www.topo.com to see if a new version is available that supports upload 
and download for your receiver.) 
6. TOPO! will automatically set the baud rate and receiver limits for the receiver you selected in step 5. If 
you need to, you can edit any of the limits or settings by entering new values in the text boxes on the GPS 
Setup screen. 
7. If you have changed the baud rate (i.e. transfer speed) in your GPS receiver, verify that the Baud Rate 
specified on the GPS Setup screen matches your GPS receiver’s baud rate. (See your GPS receiver 
manual for more information about setting the baud rate.) 
8. Verify that the COM Port specified on the GPS Setup screen is the same port you connected the cable 
to in step 1. (If you aren’t sure, try each of the options in the pull down menu, starting with COM1, and 
clicking the Test GPS Connection button each time.) 
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9. Click the Test GPS Connection button. A properly connected receiver will send a message that includes 
the text “OK”. You are now connected and ready to send and receive data. (If you do not receive this 
message, try checking your cable connections, restarting your receiver, and repeating the above 
instructions. If you continue to have trouble, visit our web site at www.nationalgeographic.com/topo 
to see if a recent solution has been posted to the support page.) 
 
TOPO! supports most popular handheld GPS receivers. If you do not see your receiver manufacturer or 
model in the pull down menus on the GPS Setup screen, visit www.topo.com for a complete list of 
supported receivers and downloadable upgrades for new models. Also visit our web site for new 
“Connecting to GPS” updates and free upgrades. 
 
(Note: TOPO! requires a good cable connection between your GPS receiver and the communications port 
on your PC. Make sure the PC cable is correctly attached to both your receiver and the PC.) 
 
15.5 Uploading to a GPS Receiver (Export Wizard) 
 
Exporting data from TOPO! to your GPS receiver is a great way to help you get where you want to go.  
When you export waypoints and routes created in TOPO!, they become available to you in your GPS 
receiver. When you’re out using your GPS, you’ll be able to select any of those waypoints or routes, and 
your GPS will help guide you to them.  Creating waypoints and routes in TOPO! is much easier than 
creating them manually in your receiver. Just click on the map to place waypoints, and use the keyboard to 
give those waypoints names. Uploading data directly can save hours of work. Waypoints and routes will 
appear in your receiver as you named them in TOPO!, and if your receiver supports waypoint messages, 
they will appear as well. TOPO! allows to store all your GPS data on your PC. Just load the data you need 
for a particular trip into your receiver and your GPS will have a list of waypoints that’s easy to manage and 
keep track of when you’re using it. When you return, download all the GPS data and save it in a .tpg file. 
This way you can delete old waypoints and routes from your receiver, but still have a backup on your PC 
hard drive if you ever want to upload them again to the GPS. 
 
To upload to a GPS receiver: 
 
1. Connect your GPS to your computer (see section 14.4 above). 
2. Select Export Wizard… from the GPS menu. The Wizard screen will appear. 
3. Specify To a GPS receive r that is now connected to the PC as the destination of your GPS data, and 
click the Next button. 
4. Choose the type of GPS information you wish to export, and specify datum and GPS settings. 
5. Before you begin exporting to your GPS, you may wish to test the connection with your PC by clicking 
the Test GPS Connection button. 
6. Click the Finish button. Depending on what you requested in step 4, you should see waypoints and/or 
routes now stored in your GPS receiver. 
 
(Note: In order to import directly from your GPS receiver, you must have the necessary cable and your 
receiver must support PC upload / download. If you are having trouble, see 15.4 Connecting to a GPS 
Receiver.) 
 
(Tip: Print a map from TOPO! with the Waypoint Labels preference turned on. The names of waypoints on 
the printed map will correspond exactly with the waypoints  you have loaded into your receiver.) 
 
15.6 Downloading from a GPS Receiver (Import Wizard) 
 
Importing data from your GPS receiver is an excellent way to see where you’ve been. When you import 
waypoints, routes, and/or tracks into TOPO!, they automatically appear on the maps. Importing data is also 
a good way to manage and store GPS data gathered in the field. Once you’ve downloaded waypoints into 
TOPO! and saved them on your hard drive (see section 15.9 below), you can clear them from your GPS 
receiver so you won’t have to scroll through them all when using your GPS on your next trip. If you need 
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to access the waypoints in the future, you can always open the file in TOPO! and upload them back to your 
receiver. 
 
To download from a GPS receiver: 
 
1. Connect your GPS to your computer (see section 15.4 above). 
2. Select Import Wizard… from the GPS menu. The Wizard screen will appear. 
3. Specify In a GPS receiver that is now connected to the PC as the source of your GPS data, and click 
the Next button. 
4. Choose the type of GPS information you wish to import, and specify datum and GPS settings. 
5. Before you begin importing from your GPS, you may wish to test the connection with your PC by 
clicking the Test GPS Connection button. 
6. Click the Finish button. Depending on what you requested in step 4, you should see waypoints, routes, 
and/or tracks appear on the maps and in the Waypoint List. 
 
(Note: In order to import directly from your GPS receiver, you must have the necessary cable and your 
receiver must support PC upload / download. If you are having trouble, see 15.4 Connecting to a GPS 
Receiver.) 
 
15.7 Tracking your Position in Real Time 
 
Portable computer users can track their location in real time as they travel by having their GPS receiver 
send location updat es to TOPO! at regular intervals. You might want to try this when searching for a 
trailhead or navigating on dirt roads. Please be careful - don't click and drive.  
 
Displaying or marking your current position a single time 
 
1. Connect your GPS to your computer (see section 15.4 above). 
2. Verify that your GPS receiver is locked on to at least 3 satellites and has a position fix. 
3. Select Show Current GPS Position from the GPS menu to center the map and cross hairs on your 
position. 
4. Or, select Mark Current GPS Position… to record the position as a waypoint on the map. 
 
Tracking your position continuously as you travel 
 
1. Connect your GPS to your computer (see section 15.4 above). 
2. Verify that your GPS receiver is locked on to at least 3 satellites and has a position fix. 
3. Select Setup Automatic Tracking… from the GPS menu. There are 3 options for how you want your 
track displayed and recorded. You can choose any or all of them: 
4. Checking the Show Position checkbox will center the map on your location as often as you choose 
(default: every 5 seconds). 
5. Checking the Mark Position checkbox will create successively numbered waypoints on the map at your 
location as often as you choose (default: every 30 seconds). Also check the Don't mark if position is 
within 500 feet of previous waypoint checkbox if you want to avoid creating lots of waypoints in the 
same place when you are stationary. 
6. Checking the Trace out a continuous freehand route checkbox will connect your movements on the 
map with a single continuous route (in the current default color and style.) 
7. Click the Start Tracking button. 
8. To stop tracking, toggle the GPS Options button on the toolbar, or deselect Setup Automatic 
Tracking… from the GPS menu. 
 
(Note: If you are having trouble, mak e sure that your receiver is tracking enough satellites and has a valid 
position fix. Also see 15.4 Connecting to a GPS Receiver.) 
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15.8 Managing Waypoints and Routes – The Waypoint List 
 
The Waypoint List provides TOPO!GPS users a way to easily view and sort through the currently open file 
of waypoints and routes. By double-clicking on a waypoint in the list, you can jump right to it on the map.  
By double-clicking on a route folder, you can quickly activate it for editing. The list can also be used to edit 
GPS routes, and cut, paste, or delete multiple waypoints at one time.  To open or close the Waypoint List, 
select GPS Waypoint List from the View menu. You can also open, close, or resize the list by dragging 
the bar that separates it from the map pane. 
 
(Note: When a GPS route is “active,” it will appear red on the map and in the Waypoint List. Any new 
waypoints you place on the map will be added to the end of an active route. Inactive routes appear blue.  
The yellow folder called All Waypoints in File lists all the waypoints in all the routes as well as waypoints 
that are not part of any routes. Open this folder to place waypoints on the map that you do not want to 
append to any of the GPS routes.) 
 
Sorting the waypoint list 
 
By default, waypoints will be shown in alphanumerical order in the Waypoint List. Waypoints can also be 
sorted by latitude, longitude, elevation or other criteria just by clicking the appropriate Waypoint List 
column heading. For example, if you want to find the closest waypoints to a given location on the map, 
choose Compass from the Tool menu and click on that location to place the Anchor symbol. Then, click 
the column heading titled To Anchor at the top of the Waypoint List. The waypoints will be reorganized 
and listed in order by how far they are from the anchor symbol on the map. 
 
(Tip: If you’re printing a map and just want to upload the waypoints that appear on it to your GPS, sort the 
list by clicking on the In Selection column. Then highlight the group labeled "Yes" and upload them via the 
Export Wizard.) 
 
Editing GPS routes using the waypoint list 
 
Existing waypoints can be cut and pasted into GPS routes from the Waypoint List. Right -click on a 
waypoint or route in the list to access its pop-up option menu. For details on how to construct a route in this 
manner, refer to the end of section 15.3 above. 
 
15.9 Importing / Exporting GPS Data to Other Applications 
 
Waypoint and route information can be exported to your clipboard or saved as a text file. In these formats, 
GPS data can be printed for manual entry into a GPS receiver, or shared with other software applications.  
 
Exporting GPS information from TOPO! to other applications 
 
1. Select the Export Wizard from the GPS menu. 
2. Choose to have the GPS data sent to a text file or the clipboard for use with other applications. 
3. Next, choose which GPS objects (routes, waypoints or both) you wish to export. 
4. Finally, choose a Format for the data. The default is Comma-delimited Text, which should transfer into 
other applications such as Word or Excel. If you are exporting GPS data to another waypoint management 
application, see if it is listed as one of the export formats. If not, try using the default format -- many 
applications can import comma-delimited text. Visit our web sit e at www.nationalgeographic.com/topo for 
more suggestions and troubleshooting tips. 
5. The desired GPS data will now be available to you from your clipboard or as a text file on disk. If you 
wish to print the list, paste it into Word, Excel, or some other text editor and print from there. You can then 
use the printed list of waypoint coordinates to manually enter GPS data into your receiver per the 
instructions in your GPS user manual. 
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Importing GPS information into TOPO! from text files or the clipboard 
 
1. Select the Import Wizard from the GPS menu. 
2. Choose between text file or the clipboard as the source of your data. 
3. If you are importing from a text file, you will be prompted to select the source file to be opened. 
4. The Import Wizard will ask how different data fields are separated (Commas, Tabs, Spaces or some 
Other character of your specification.) When you select the proper format, the data should line up in the 
Preview Window in straight columns. 
5. Follow the instructions on-screen, until you get to the Final Step with the Finish button. 
6. For the final step, you must identify each column of data in the Data Preview area so that TOPO! Will 
know what each column means. Click on each column heading and a pop-up menu will appear. Use the 
pop-up menu to specify the type of information contained in each column (i.e. Column 1 = name, Column 2 
= Latitude Degrees, Column 3 = Latitude Minutes, etc.) 
7. Left-click on the Finish button to bring the waypoints or routes into TOPO!. 
(Note: If none of the data imports properly, try again and pay particular attention to how you categorize 
each column in step 6. If this still fails, it is likely that the data you are trying to import is not compatible 
with TOPO! at this time.) 
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16.0  Using Back Roads Explorer with PDAs 
 
Exporting maps to your PDA is a great to way to take TOPO! to go. Map exports include any custom notes, 
routes symbols or other information you have added to the maps. Once you have exported maps from 
TOPO! they become available to Pocket TOPO!. Pocket TOPO! is a software application that runs on your 
handheld computer. It lets you do the most of the things you can do with TOPO! on your home PC. To get 
started exporting maps, first install Pocket TOPO!. 
 
16.1 Installing Pocket TOPO! 
 
1. Connect your handheld to your PC. 
2. Click the GPS and Handheld options button on the TOPO! toolbar. 
3. Choose from the Install Pocket TOPO! options. 
4. Follow the on-screen wizards instructions. 
5. Once you have successfully installed Pocket TOPO! you can begin exporting maps. 
 
16.2 How do I export maps to a handheld?  
 
1. Connect your handheld to your PC. 
2. Use the print / export tool on the TOPO! toolbar to define the section of map you wish to export (see 
Selecting an Area of Map to Print). 
3. On the print preview screen (to the right of your map pane) choose the PDA file tab. 
4. Click Export to handheld. 
5. Following the on-screen wizards instructions. 
 
(Note: The size of the area of map you can export is limited by the amount of free memory available on 
your handheld computer. The export wizard will confirm how much free memory you have before 
exporting. To learn more about managing or expanding your handheld memory check with your handheld 
user guide or manufacture.) 
 
(Tip: You can export one or multiple levels of maps. To export multiple levels, zoom to the most detailed 
map you wish to export and choose the print / export tool.) 
 
(Tip: Machines fail, batteries die, and glare from the sun can make viewing a screen difficult. For all of 
these reasons it is always a good idea to take a printed map along in addition to a handheld computer or 
GPS receiver.) 
 
16.3 Using Pocket TOPO! 
 
Pocket TOPO! allows you to work with TOPO! maps on your PocketPC device. Simply clip out a section 
of map from the desktop TOPO! software and export it to your handheld. All your symbols, routes, text, 
notes and direction lines will be available for viewing and modifying in Pocket TOPO!. 
(Note: Large maps may consume large amounts of memory on your device so it is recommended that you 
select an area that is no larger than you need. Maps with a lot of custom routes, symbols, and notes may 
perform slowly.) 
 
You may also add new TOPO! objects to a map by clicking on tool icons at the bottom of the screen, then 
interacting with the map while the tool is selected. 
 
16.4 Moving around on a map 
 
Pocket TOPO! provides two ways to move around on a map. 
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Grab  
 
When the navigation tool is in grab (hand icon) mode you can simply tap on the map and drag it to a new 
position. 
 
Travel 
 
To cause the map to “travel” in a certain direction you must place the navigation tool into travel mode 
(indicated by a four-way arrow icon). Once in the travel mode simply tap on the map to cause it to move. 
 
16.5 Using Symbols 
 
Symbols are typically used to indicate a place on the map that you wish to remember. 
To place a new symbol: 
1. Tap the symbol tool (pushpin icon). 
2. Tap any point on the map. 
3. Tap the symbol to display the Symbol Properties dialog. 
 
16.6 Using Text 
 
You can place text anywhere on the map to help annotate trails or waypoints you have created.  To place 
text on the map: 
1. Tap the text tool (“A” symbol). 
2. Tap the map where you wish to place the text. 
3. The Text Properties dialog will open. 
4. Enter the text to display and tap OK. 
 
16.7 Using Routes 
 
Routes represent trails or roads for travel. 
To draw a route: 
1. Tap the route tool (ruler and pencil). 
2. Tap on the map and drag. 
3. Tap anywhere on the route to display the Route Properties dialog. 
 
16.8 Using Notes 
 
Notes are used to record information about a certain geographical place. 
To create a new note: 
1. Tap the note tool (notepad icon). 
2. Tap the map where you wish to place the note. 
3. The Note Properties dialog opens. 
4. Enter notes and an optional web link and tap OK to close the dialog. 
 
(Note: Add new photos using the desktop version of TOPO!) 
 
16.9 Using Direction Lines 
 
Direction lines can be used to find the straight-line distance and bearing from one place to another. 
 
To draw a direction line: 
 
1. Tap the direction line tool (North symbol). 
2. Tap once on the map to place an anchor (the start of the line). 
3. Tap again at the ending point and drag to move the arrowhead. 
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16.10 How do I Put maps on my handheld computer? 
 
Use the desktop version of TOPO! to copy maps to your Pocket PC. Within TOPO! you can select a 
portion of a map to be sent to your handheld device.  
(Note: Maps can occupy a large amount of memory on your handheld device so you should select only the 
portion of map that you will need.) 
 
16.11 How do I change my display units? 
 
Pocket TOPO! allows you to view display units in several formats. To change the display units tap the 
“Tools” menu near the lower-left corner of the screen, and choose Options from the menu. 
 
16.12 How do I locate a point on the map?  
 
To locate a point on the map simply tap in any open space. A context menu will appear. Choose Map 
Location from the menu. A dialog will tell the latitude and longitude of the point on the map. 
 
16.13 How do I read a TOPO! map?  
 
The ups and downs of an area - its mountains and hills, its valleys and plains - are shown on a topographic 
map by thin brown lines called contour lines. A contour line is an imaginary line on the ground along 
which every point is at the same elevation above sea level. The distance in elevation between one contour 
line and the next is called the contour interval.  Some contour lines are marked with the interval at that 
point, others must be determined by adding the contour interval from a known line to line you need to 
know. When contour lines are far apart and evenly spaced, they will indicate a gentle slope; when they are 
close together they show a cliff or steep incline.  When contour lines cross a river or a stream they take on a 
V shape, with the point of the V pointing uphill; when they denote a ridge of a hill they become U-shaped, 
with the bottom of the U pointing downhill. 
 
(Tip: Because the processing power on your handheld computer is limited, you may experience difficulty 
navigating maps with many custom routes, symbols, and notes.) 
 
16.14 Updating desktop TOPO! with information from Pocket TOPO! 
 
Annotations that you make to the maps in the field using Pocket TOPO! can be made available to TOPO! 
on your PC by importing a map: 
 
16.15 How do I import a map from a handheld computer to TOPO!? 
 
1. Connect your handheld to your PC. 
2. Click the GPS and Handheld options button on the TOPO! toolbar. 
3. Choose Import Map from Handheld. 
4. Follow the on-screen wizards instructions. 
5. A list of maps stored on your handheld will appear. 
6. Choose the map you wish to import and click finish. 
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17.0  Linking Notes to Maps (Photos, Text, Websites and Documents) 
 
Use the notes tool to annotate the maps with custom photos, notes, links to websites and documents. When 
you place a note on the map, the note is displayed in the notes pane and as an icon the map. A single note 
may contain text, photographs and a link to a website or document. TOPO! can link any digital photo to the 
map. Digital photos can be taken with a digital camera, downloaded from the Internet, attached to e-mail, 
or captured with a scanner. To learn more about digital photos and your computer check the help section of 
your PC. 
 
17.1 To add notes to the map: 
 
1. Choose Notes from the Tool Menu. 
2. Position the cursor and left click on the map. 
 
(Tip: Notes contain properties that can be edited in the Notes Property Window; a single note can contain 
text, a photo, and a link to a document or web site.) 
 
17.2 To add a text note to the map: 
 
1. Choose Notes from the Tool Menu. 
2. Position the cursor and left click on the map. 
3. Enter your text in the Notes Property Window and click OK. 
 
(Tip: To add text directly to the map, use the Text Tool.) 
 
17.3 To add a photo to the map: 
 
1. Choose Notes from the Tool Menu. 
2. Position the cursor and left click on the map. 
3. Click the browse button in the Notes Property Window, choose a photo from 
your file directory, and click OK. 
 
(Tip: Checking link to the above photos originally file automatically places a link to the original photo in 
your note. If your PC is configured to display photos, clicking the link will display the full size photo.) 
 
17.4 To add a link to a website: 
 
1. Choose Notes from the Tool menu. 
2. Position the cursor and left click on the map. 
3. Choose Link To Website in Notes Property Window. 
4. Enter the address for the website you want to link to and choose OK. 
 
17.5 To add a link to a document: 
 
1. Choose Notes from the Tool menu. 
2. Position the cursor and left click on the map. 
3. Choose Link to Document in Notes Property Window. 
4. Enter or browse for the location of the document and click. 
 
(Tip: You can link to any type of document including media clips such as movies and sounds. Clicking the 
link will play a movie or sound if your PC is configure to play these types of files.) 
 
17.6 To edit a note: 
 
Right click a notes icon on the map or in the Note Window to open the Notes Property Window for 
editing. 
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17.7 To move a note: 
 
1. Choose a note by positioning your cursor over it. 
2. Hold down the left mouse button and drag. 
 
(Tip: Check the bookmark-only box in a Notes dialogue box to create a note without a corresponding icon.  
This is useful when you want to make it easy to jump to a specific location on the map but don’t want to 
clutter the map with icons.) 
 
17.8 Opening and closing the Notes Window 
 
To close or reopen the Notes Window, click on the gray bar to the left or choose Notes from the View 
menu. 
 
17.9 Using folders to organize information 
 
Notes information can be easily organized in folders. Storing information in folders lets you easily access 
notes related to a specific trip, activity, or projects. Closing folders helps keep the Notes windows 
organized. You can cut, paste, copy, and create new folders by right clicking on a note. 
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TOPO! Appendices: 
 
A. Pop-up Editors 
 
Any custom information you add to a map in TOPO! - routes, waypoints, direction lines, text labels and 
symbols - can be thought of as objects. All objects contain pop-up editors that provide options. 
 
To access a pop-up editor: 
 
1. Select an object by placing your cursor over it. The cursor will change to a hand symbol. 
2. Click the right mouse button and the editor will appear. 
 
(Tip: Waypoints and GPS routes can only be edited or activated when you are using the Waypoint Tool. To 
Pop-Up an editor on a waypoint, be sure you are using the Waypoint Tool. To Pop-Up an editor on other 
TOPO! objects, use any tool except the Waypoint Tool.) 
 
Setting the Default Appearance for Objects Created in TOPO! 
 
The initial appearance (color, font, width, etc.) of objects created in TOPO! is defined by a tool’s default 
settings. The Use As Default command, located in an object’s pop-up editor, allows you to set the default 
to match that object's appearance.  For example, if you would like the Route Tool to draw thick green lines 
when you use it, you would first create a route on the map and set its Color to green and its Style to thick. 
Then, choose Use As Default from its pop-up editor. All routes you draw in the future will also be green 
and thick (unless you change the default again to something else). 
 
(Note: Waypoints and GPS Routes do not have appearances that can be individually changed. You can 
change how the waypoint labels appear from the Preferences menu, and this will affect the labels on all of 
the waypoints at once.) 
 
B. Modifying and Deleting Objects 
 
Most objects you add to a map in TOPO! can be displayed on any or all map levels or deleted entirely.  
Waypoints and GPS Routes are the exception; they automatically appear on all levels of map. 
 
To copy objects to other map levels: 
 
The Modify Style button (located in an object’s pop-up editor) allows you to copy an object from the map 
level it was created on to other levels of map. For example, a long route drawn across many screens at the 
most detailed level could be copied to a less detailed level to be viewed in its entirety on one screen. 
 
To copy routes, symbols and text to other map levels: 
 
1. Choose Modify Style from an object’s pop-up option menu. 
2. A menu of map levels will appear with checkmarks next to levels on which the object is currently 
displayed. 
3. Left-click an unchecked level to copy the object to that level. 
4. Or, left-click a checked level to remove the object from that level. 
 
(Note: Waypoints and GPS Routes automatically appear on all levels of map.) 
 
Deleting objects 
 
Any objects you add to a TOPO! map can be deleted by selecting Delete from the pop -up editor, or by 
using the delete button on your keyboard. 
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To delete an object using the option menu: 
 
1. Choose the object you wish to delete by positioning your cursor over it. 
2. Right click on the object and select Delete from the pop-up editor. 
 
To delete an object using the keyboard: 
 
1. Choose the object you wish to delete by positioning your cursor over it. 
2. Press the delete key on your keyboard. 
 
(Reminder: Deleted objects are permanently deleted. Save multiple versions of a .tpo file on your hard 
drive if you want to be able to go back to an earlier version later.) 
 
C. Preference Settings 
 
The Preference menu at the top of the screen lets you customize tool settings, display options, and units of 
measure. Checkmarks next to items indicate options that are currently selected. Choose an unchecked item 
to select it instead. 
 
Coordinate Display: Allows you choose how coordinates are displayed and what map datum the 
coordinates are referenced to. Choose from: 
Degrees, Minutes, Seconds : Displays degrees followed by minutes and seconds 
Degrees, Minutes.Minutes : Displays degrees and decimal minutes 
Degrees.Degrees : Displays decimal degrees 
UTM: Displays Universal Transverse Mercator coordinates 
NAD27 Datum: View latitude and longitude in North American Datum of 1927 (NAD27) 
NAD83 / WGS84 Datum: View latitude and longitude in North American Datum of 1983 (NAD83), 
which is essentially equivalent to WGS84. 
Distance Units: Distance can be displayed in miles or kilometers. 
Elevation Units: Elevation can be displayed in feet or meters. 
Traveling Tool: Allows you to control how fast the maps scroll while you are using the traveling tool.  
These settings only affect maps that are already in memory and cannot change how fast maps load from 
your CD-ROM drive. Change this setting if TOPO! is scrolling the maps too quickly or too slowly. 
 
 
Print Tool: menu allows you to specify your preferred print settings. Options include: 
Page Setup: Allows you to specify paper size and source, portrait or landscape orientation, and print 
margins. 
Select 1 Full Page: Automatically defines a print selection area that will fill one page. 
Custom Magnification: Use this option to magnify or shrink user-defined selection areas to print on one 
page, or to print at a specific magnification factor. 
Include Scale Bar: Includes a map distance reference bar in your print. 
Include North Arrow: Places an indicator on your print identifying both true and magnetic north. 
Include Grid Labels: Prints the latitude and longitude or UTM coordinates of the grid lines along the 
edges of the printed map. If you have chosen not to include grid lines on your map, TOPO! will print the 
coordinates of the four corners of your print area instead. 
Include Header: Includes by default the name of the .tpo file from which a map comes, as well as the date. 
To modify the header, choose this option. This will display the full text of the current header, which can 
then be edited or changed. 
Include Elevation Profile: Includes the most recent elevation profile that has been generated for a route at 
the bottom of the printed map. 
Output in Grayscale: Use this option for best results when printing maps in black and white. 
Scroll the Map to View: This option permits you to view the boundaries of your selection area.  
Move Selection Boundaries: Allows you to move the selection area in a particular direction to an adjacent 
map area for printing tiled maps. 
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Compass Tool: Allows you to customize how direction is displayed and how the compass tool works. You 
can toggle between the following: 
True North: The direction that most topographic maps are oriented toward (straight up on the map). 
Magnetic North: The direction most compasses point toward. 
Radial Mode: The anchor point remains fixed at point A when a direction line is created from point A to 
point B. This is useful when you want to measure direction from one location on the map to several other 
locations. 
Waypoint Mode : The anchor point moves to point B when a direction line is created from point A to point 
B. This is useful when you want to measure a series of directions along a route. 
 
GPS Settings: Opens a window that lets you change the following GPS settings: 
GPS Receiver : Specify the manufacturer of your GPS receiver. TOPO! supports GPS receivers made by: 
Eagle/Lowrance, Garmin and Magellan, as well as any receiver that outputs NMEA sentences (for real-
time tracking only.) 
COM Port: Specify which COM port the GPS receiver is connected to. If the COM port number is not 
apparent, try them all, starting with COM1. 
Baud Rate: Set the baud rate for transferring data to and from your GPS receiver. If you have trouble 
transferring data successfully, it may be helpful to decrease the baud rate.  
Test GPS Connection: Verify a working connection between GPS receiver and computer. 
Receiver Limits: Specify parameters for text characters, maximum numbers of waypoints, routes and 
tracking points, etc, that your GPS receiver can accept. These settings should be made automatically when 
you choose a receiver type from the pull-down list; however, you can edit these settings if you need to. 
 
Waypoint Labels: Choose which information to include in waypoint labels: 
Name Only: Displays the waypoint name only. 
Coordinate Only: Displays the waypoint coordinates only. 
Both Name and Coordinate: Displays both name and coordinates. 
Hide Waypoint Labels: No waypoint label displayed (just the waypoint symbol). 
Backdrops On/Off: Backdrops highlight Waypoint Label information, making label text stand out on the 
map. If you find that other useful information is being obscured by these backdrops, you may prefer to 
leave them off. 
Time Format: Choose between UTC (Universal or Greenwich Mean Time) and local time in 12 or 24 hour 
format. Time is recorded along with location each time a waypoint is created. 
 
D. Tips, Tricks & Frequently Asked Questions 
 
Why are some street names missing from the map?  
The emphasis of the maps in TOPO! is on topography -- depicting the terrain and natural landscape. In 
urban areas, a map shows the maximum number of street names compatible with the map scale after the 
application of essential descriptive labels and other features’ names. Preference is given to the named 
principal or through arteries. Additional names are shown at intervals to serve as ready points of orientation 
without unduly congesting the maps. 
 
Why are some features incorrect or missing from the map?  
National Geographic Maps uses the most current maps available at the time of publication. While most 
landforms are correct, man-made features such as roads or trails may be missing or incorrect because the 
maps have not been updated. To check the publication date of 7.5' USGS map in TOPO!, choose About the 
Maps from the Info menu. 
 
What about updates? 
As new paper maps and data become available, National Geographic Maps will provide upgrades. Be sure 
to return the product registration card included with this product. It will help us to notify you as upgrades 
become available. Upgrades will be available on CD-ROM and downloadable from the Internet. Visit 
www.nationalgeographic.com/topo for update information. 
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Why won’t Back Roads Explorer work with my printer? 
Your printer must be compatible with Microsoft Windows and support printing of grayscale or color 
graphics to work with TOPO!. If your printer is compatible with Microsoft Windows and you are still 
having problems, see Appendix E Troubleshooting. 
 
How can I reverse the direction of an elevation profile? 
TOPO! builds elevation profiles from the start point of a route to the end point. You can reverse the 
direction that a profile builds by adding a small segment of route to the start point and then rebuilding the 
profile, see 8.4 Extending or Shortening a Route . 
 
What if the map I want to print is larger than a page? 
There are several ways to print a large region of map from TOPO!  See 12.8  
Suggestions for Printing Large Maps. 
 
How can I find everything within a one-mile radius of a central point? 
Use the Compass Tool to place an anchor at the central point. From the “Preference” menu be sure that the 
Compass Tool is set to “Radial Mode.” As you move the cursor, the distance from the anchor point to the 
cursor is displayed in the left corner of the status bar. When the cursor is exactly one mile from the anchor 
point, click to draw a direction line. Continue this process for at least 8 different points spread in a circle. 
Use the Ruler Tool’s straight line mode to connect the ends of the directions line you have placed. You 
may then delete the direction lines and what remains should be polygon roughly 1 mile in diameter. 
 
How can I determine if a location (such as a summit) is visible from another location (such as a trail 
intersection)? 
Draw a direction line using the Compass Tool from one of the locations on the map to the other, see 
“Measuring Direction” (Section 10.0). Then build an elevation profile from the Pop-up Editors of the 
direction line, see “Building and Printing Elevation Profiles” (Section 11.0). Hold a straight edge (such as a 
ruler or piece of paper) up against the monitor or printed profile so that its edge passes through the start and 
end points of the profile. If any land comes between the two locations out in the field, you should see a 
portion of the elevation profile sticking up above the straight edge as well. 
(Note: There may still be trees, buildings, or other obstructions between the two locations that are not 
accounted for by the elevation data corresponding to the ground.) 
 
How can I keep track of information I have added to the maps? 
Use the Bookmark Tool to keep track of any information you add to the maps. This will both create a list of 
information you have added and let you quickly get back to it later. For more information about managing 
your maps, see 6.0 Managing your Maps and Saving your Work . 
 
How can I create a map to print somewhere else? 
Set up the map as if you were going to print it. Instead of using the Print Map command, use the Export 
Map to Disk… command. Save the map to a floppy disk in a graphics format of your choice. You now 
have a standard graphics document that can be opened by an image processing or desktop publishing 
program. Bring the floppy disk to another location to print at and open the file you created with a standard 
image processing or desktop publishing program. 
 
How can I load maps onto the hard drive of a laptop computer? 
When you run the Installer, a “TPO_DATA” folder is created on your hard drive. You should find this 
folder in the same directory as the TOPO! application (probably in “C:\TOPO!\”). Each CD  will have a 
folder on it called BR_D03 (for example Back Roads Explorer disc 3).  Copy this folder and place it inside 
the TPO_DATA folder.  Next time you open up TOPO!, the maps should be read from the hard drive. 
 
How can I get more information about TOPO! and the different map regions currently available? 
Contact National Geographic Maps or visit www.nationalgeographic.com/topo. 
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E. Troubleshooting 
 
This section lists some common problems that users have encountered and how to solve them. If you 
encounter problems that are not discussed in this manual, please contact us for assistance:  
 

1. View online support information at: www.topics -ent.com/support/ 
2. Or, contact us by email at helpdesk@topics-ent.com 
3. Or, call for technical assistance at (425) 656-3621. 

 
When contacting us, please describe the problem and tell us that you are using Back Roads Explorer. 
 
Problem: “Can’t print” or “TOPO! freezes when trying to print:” 
 
Your printer must be compatible with Microsoft Windows and support printing of grayscale or color 
graphics to work with TOPO!. If your printer is compatible with Microsoft Windows and you are still 
having problems, check to be sure that are you using the most current printer driver. See the documentation 
that came with your printer or contact the printer’s manufacturer to find out more about printer drivers. 
As with any large graphics files, printing TOPO! maps may consume large amounts of memory (RAM) and 
may take time on many printers. If it seems like your computer has frozen while waiting for a map to print, 
try waiting a few minutes. If the computer is still frozen, press the Ctrl-Alt-Delete keys to exit TOPO! 
and/or restart Windows. Then, run TOPO! and try the following: 
 
1. If the error message reads: “Could not create appropriate bitmap,” or “Unable to copy image,” try 
closing TOPO! and setting the monitor to display 256 colors (right-click on the desktop and choose 
Properties then choose Settings). This will let you print a much larger area of map with the same amount 
of memory. Restart TOPO! and try your print again. 
 
2. If step 1 did not solve the problem, try printing a small map (2” x 2”). If this works, the problem is most 
likely that you need more memory. Graphic images, like the maps in TOPO!, require more RAM to print 
than other types of images. 
 
3. Other things to try: Turn the printer off and then on again (this will clear the printer’s memory cache). If 
you are on a network, disconnect from the network and try again. 
 
 
Problem: “Can't get GPS link to work:” 
 
If you are having trouble with a GPS connection or can't upload or download GPS data, see 15.4 
Connecting to a GPS Receive r. If you still have trouble, visit our support page at 
www.nationalgeographic.com/topo for information about particular brands and models of GPS receivers. 
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